# Contents

*About This Book* ................................................................. v
*What's New in SAS Model Manager 14.2* .............................. vii

**Chapter 1 • Introduction to SAS Model Manager Administrator's Guide** ................................................. 1
Overview of SAS Model Manager Administration ......................... 1

**Chapter 2 • Performing Pre-installation Tasks** ......................... 3
Pre-installation Steps ................................................................. 3
Determine the Database to Use ...................................................... 4
Pre-installation Tasks for SAS Decision Manager Common Data Server .................................................. 4
Pre-installation Tasks for an Oracle Database .................................. 5

**Chapter 3 • Installing SAS Model Manager** .............................. 9
Products Installed with SAS Model Manager ................................. 9
Running the SAS Deployment Wizard ............................................. 9

**Chapter 4 • Performing Post-installation Tasks** ......................... 11
Post-installation Configuration and Verification Steps .................... 12
Update User Passwords for Local User Service ............................... 13
Create Users and Assign Permissions ............................................. 14
Creating Operating System Accounts for Product Administrators and Users ........................................... 14
Verify WebDAV Folder Permissions for User-Defined Templates ............... 17
Add a New Workspace Server and Create a SAS Application Server Context ........................................... 19
Extend Support for Double-Byte Characters in Table and Variable Names ........................................... 21
Create Oracle Database Tables ................................................... 21
Verify the Certificate ................................................................. 22
Configure Your Deployment for HTTPS .......................................... 22
Configure Your Deployment for Single Sign-On Web Authentication .......... 23
Configure Users Authenticated by Kerberos for Publishing Models ............. 24
Configure Support for Executable Attachments ................................ 25
Configure the Dashboard Reports Directory .................................... 26
Configuring Model Manager Java Services Options ......................... 27
Configuring the Limitation for the Number of Observations for a Scoring Result Set .................................... 34
Modify Log File Settings .......................................................... 34

**Chapter 5 • Performing Upgrade Tasks** .................................. 37
Overview of the Upgrade Process ................................................ 37
Upgrade Steps ................................................................. 37
Post-upgrade Steps ............................................................ 39

**Chapter 6 • Configuring Users, Groups, and Roles** ....................... 41
Security Administration Tasks for SAS Model Manager ....................... 41
Administering SAS Identities for Users .......................................... 42
Groups and Group Membership .................................................. 43
Roles and Capabilities ............................................................. 44
Administering Group and Role Membership .................................... 46
Model Management User Tasks .................................................. 48
About This Book

Audience

This guide is for the following users:

• Those who are responsible for administering SAS Model Manager.
• Those who are responsible for administering the SAS Metadata Repository for use with SAS Model Manager.

You might be assigned to a specific user group or role. That assignment determines which tasks you can perform. For more information, see Chapter 6, “Configuring Users, Groups, and Roles,” on page 41.

Prerequisites

Here are the prerequisites for administering SAS Model Manager:

• The following software must be installed on your computer:
  • SAS Web Server and SAS Web Application Server
  • SAS Management Console 9.4

For more information, see SAS Intelligence Platform: Installation and Configuration Guide.

• You must have a user ID and password for logging in to SAS Management Console and SAS Content Server Administration Console.

Conventions Used in This Document

The following typographical conventions are used for all text in this document except for syntax:

**bold**

identifies an item in the SAS Model Manager window or a menu item.

*italics*

identifies a book title or a value that is supplied by the user.
monospace
    identifies SAS code.

UPPERCASE
    identifies a SAS language element, such as the SAS statements KEEP or DROP.

The following typographical conventions are used in syntax:

**bold**
    identifies the name of a macro.

*italic*
    identifies an argument that must be supplied by the user.

< >
    identifies an optional macro argument.

| (vertical bar)
    indicates that you can choose one value from a group. Values that are separated by
    the vertical bar are mutually exclusive.

UPPERCASE
    indicates a keyword that can be used as a value for an argument.
What's New in SAS Model Manager 14.2

Overview

New features and enhancements make it possible for SAS Model Manager customers to do the following:

- configure users who are authenticated by Kerberos for publishing models to Hadoop and Teradata
- extend naming support for double-byte characters in table and variable names
- update user passwords for local user service

SAS Model Manager 14.2M1 on SAS 9.4M6 enables you to do the following:

- configure support for executable attachments

Configure Users Authenticated by Kerberos for Publishing Models

For users who are configured to use single sign-on web authentication by Kerberos for Teradata or Hadoop, additional Java parameters must be added to enable users to publish models from SAS Model Manager to Hadoop or Teradata. For more information, see “Configure Users Authenticated by Kerberos for Publishing Models” on page 24.

Configure Support for Executable Attachments

By default, users cannot attach executable files to objects within SAS Model Manager. However, for SAS Model Manager 14.2M1 on SAS 9.4M6, you can configure SAS Model Manager to allow executable attachments for models, projects, and portfolios. For more information, see “Configure Support for Executable Attachments” on page 25.
Extend Support for Double-Byte Characters in Table and Variable Names

If you are using a locale where national characters or multi-byte characters are used in table names or variable names, you can extend naming support for double-byte characters. For more information, see “Extend Support for Double-Byte Characters in Table and Variable Names” on page 21.

Update User Passwords for Local User Service

If you used the SAS Deployment Manager to update passwords for the SAS Administrator and SAS Trusted User, you must also update the users’ passwords for SAS Model Manager 14.2 Local Services. For more information, see “Update User Passwords for Local User Service” on page 13.
Overview of SAS Model Manager Administration

This guide provides pre-installation tasks for SAS Model Manager 14.2 on SAS 9.4, and explains both how to prepare SAS Model Manager for use and how to manage information that is associated with SAS Model Manager. The administrator uses SAS Management Console to access metadata repositories that store information about SAS Model Manager users, libraries, data tables, and the Publishing Framework. Frequently used administrative and configuration tasks are included to provide guidance after the SAS Model Manager installation process is completed. The high-level tasks include the following:

• Completing pre-installation and configuration tasks
• Complete post-upgrade steps
• Completing post-installation configuration and verification steps
• Creating and configuring published channels
• Configuring directory permissions
Chapter 2
Performing Pre-installation Tasks

Pre-installation Steps ......................................................... 3
Determine the Database to Use ............................................ 4
Pre-installation Tasks for SAS Decision Manager Common Data Server ........... 4
Pre-installation Tasks for an Oracle Database ................................ 5
  Oracle Pre-installation Tasks ............................................. 5
  Verify JDBC Drivers for Oracle ........................................ 5
  Determine the Information Required for the Oracle Database .................. 5
  Specify the Required Database Privileges for Oracle .......................... 6
  Test the Connection to Your Database .................................... 7

Pre-installation Steps

Before you install SAS Model Manager, be sure to review the Pre-installation Checklist that is provided with your deployment plan. This checklist provides a detailed list of the pre-installation requirements. It also enables you to record important information that you need when you are installing the software.

Perform the following steps before you install SAS Model Manager:

1. Verify that your system meets the minimum requirements. See the system requirements documentation on support.sas.com.

2. Determine the database that you want to use.

   Note: The SAS Decision Manager Common Data Server is always configured. Even if you use Oracle for the SAS Model Manager database, you will be prompted for information for the SAS Decision Manager Common Data Server. After your system is configured and running, you can stop the SAS Decision Manager Common Data Server.

3. Complete the pre-installation steps for your database. See “Pre-installation Tasks for SAS Decision Manager Common Data Server” on page 4 or “Pre-installation Tasks for an Oracle Database” on page 5.

4. (Optional) If you plan to configure the SAS Decision Manager Common Data Server for high availability, gather information about the high-availability cluster. For information, see the technical paper Managing SAS® Web Infrastructure Platform Data Server High-Availability Clusters on UNIX.
Determine the Database to Use

You can use either Oracle or the SAS Decision Manager Common Data Server for the SAS Decision Manager database.

The SAS Decision Manager Common Data Server is based on PostgreSQL 9.5. For more information, see “SAS Web Infrastructure Platform Data Server” in SAS Intelligence Platform: Middle-Tier Administration Guide at http://support.sas.com/documentation/intellplatform/index.html. Ensure that you have the information listed in “Pre-installation Tasks for SAS Decision Manager Common Data Server” on page 4.

SAS Model Manager supports Oracle 11g and Oracle 12c for the SAS Decision Manager database. For Oracle, complete the tasks described in “Pre-installation Tasks for an Oracle Database” on page 5.

Pre-installation Tasks for SAS Decision Manager Common Data Server

During the installation and configuration of SAS Model Manager, the SAS Deployment Wizard requires information about the database that SAS Model Manager uses.

The SAS Decision Manager Common Data Server (based on PostgreSQL 9.5) is always configured when you run the SAS Deployment Wizard. You need the information in the following table in order to complete the steps in the SAS Deployment Wizard.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Type</td>
<td>Specifies the database type to use for the SAS Decision Manager database. Select SAS Decision Manager Common Data Server.</td>
</tr>
<tr>
<td>Database Name</td>
<td>Specifies the database name. The default name for the database is dcmdb.</td>
</tr>
<tr>
<td>Database User</td>
<td>Specifies the user name for the database administrator. This user owns the database and has superuser privileges. The default user name is dcmdbowner.</td>
</tr>
<tr>
<td>Database Password</td>
<td>Specifies a password for the user ID that is associated with the database account.</td>
</tr>
<tr>
<td>Port</td>
<td>Specifies the port that is used by the database. The default port for SAS Decision Manager Common Data Server is 10482.</td>
</tr>
<tr>
<td>Host Name</td>
<td>Specifies the fully qualified host name of the server on which the database is installed.</td>
</tr>
<tr>
<td>User ID</td>
<td>Specifies the user name for the user whose credentials will be used to access the SAS Decision Manager Common Data Server database. The default user name is dcmdb.</td>
</tr>
</tbody>
</table>
Pre-installation Tasks for an Oracle Database

Oracle Pre-installation Tasks

If you are using Oracle for your SAS Decision Manager database, perform the following steps before you install SAS Model Manager:

1. Verify that you have the correct JDBC drivers.
2. Verify that you have a tnsnames.ora file for your Oracle client that corresponds to your database.
3. Determine the required database information.
   
   Note: The SAS Decision Manager Common Data Server is always configured. Even if you use Oracle for the SAS Model Manager database, you will be prompted for information for the SAS Decision Manager Common Data Server. See “Pre-installation Tasks for SAS Decision Manager Common Data Server” on page 4 for more information.
4. Specify the required database privileges.
5. Test the connection to your database.

Verify JDBC Drivers for Oracle

Verify that you have the correct JDBC drivers. To ensure proper installation of SAS Model Manager, the drivers must be on each middle-tier server, and they must be in a directory that does not contain any other files.


Determine the Information Required for the Oracle Database

During the installation and configuration of SAS Model Manager, the SAS Deployment Wizard requires information about the Oracle database that SAS Model Manager uses. Record the information in the following table.

You enter this information in the SAS Decision Manager Database Properties and SAS Decision Manager Database JDBC Properties windows.

Table 2.2 SAS Deployment Wizard Information for Oracle

<table>
<thead>
<tr>
<th>Prompt</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host Name</td>
<td>Specifies the fully qualified host name of the server on which the database is installed.</td>
</tr>
<tr>
<td>Port</td>
<td>Specifies the port number that is used by the database. The default port for Oracle is 1521.</td>
</tr>
<tr>
<td>Prompt</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Directory containing JDBC driver jars     | Specifies the location of the database vendor’s JDBC JAR file. This file must be available on the middle tier and on any machine on which you are deploying SAS Model Manager in order to configure SAS Decision Manager database.  
See “Verify JDBC Drivers for Oracle” on page 5 for more information. |
| Database SID or Service Name               | Specifies the Oracle database name. The database name must match either the service name or the Oracle site identifier (SID), both of which can be found in the tnsnames.ora file. For example:  
(CONECT_DATA = (SERVICE_NAME = mydb))  
(CONECT_DATA = (SID = mydb))  
You can also find the Oracle SID by running the following query using a database user ID on your Oracle instance:  
select instance from v$thread  
*Note:* If you select Use Oracle database name as a Service Name, then you must enter the service name that is specified in the tnsnames.ora file.  
| User ID                                    | Specifies the user ID of the database user whose credentials are used to access SAS Model Manager data on the server.                                                                                  |
| Password                                   | Specifies the password of the user ID whose credentials are used to access SAS Model Manager data on the server.                                                                                       |
| Schema Pattern                             | Specifies the schema name for the database. The default schema name is the same as the user ID.                                                                                                        |

**Specify the Required Database Privileges for Oracle**

Ensure that the users of your database have the required database privileges. Here are the required privileges for Oracle databases:

- CONNECT
- CREATE SESSION
- RESOURCE
- CREATE TABLE
- CREATE VIEW
- CREATE SEQUENCE
- CREATE TRIGGER
- UNLIMITED TABLESPACE

*Note:* The UNLIMITED TABLESPACE privilege is automatically granted for Oracle Database 11g but not for Oracle Database 12c.
Test the Connection to Your Database

Execute a command from the terminal to verify that your database is set up. For example, to use an Oracle database, you can execute the following command using SQL*Plus:

sqlplus USER/PASSWORD@ORACLE_SID

You must be able to execute this command from any directory. If you are able to execute a database command such as this only from the database installation directory, then verify that the PATH variable is set up correctly. The database client application must be installed and available on the path specified by the PATH variable.
Chapter 3
Installing SAS Model Manager

Products Installed with SAS Model Manager

Running the SAS Deployment Wizard

About Running the SAS Deployment Wizard

Select the SAS Application Server

Configure the Database

Create and Load Tables through the SAS Deployment Wizard

Products Installed with SAS Model Manager

Your deployment plan for SAS Model Manager includes additional SAS products that support and complement SAS Model Manager functionality. See the software order e-mail or the ordersummary.html file that is in your SAS Software Depot at software_depot/install_doc/order_number/ordersummary.html. The SAS Deployment Wizard prompts you to install and configure each of the products in your deployment plan.

Running the SAS Deployment Wizard

About Running the SAS Deployment Wizard

To run the SAS Deployment Wizard, follow the instructions in “Install and Configure SAS Interactively” in SAS Intelligence Platform: Installation and Configuration Guide.

Note: You can run the wizard on operating systems that do not use a windowing environment. For more information, see SAS Deployment Wizard and SAS Deployment Manager: User's Guide at http://support.sas.com/documentation/installcenter/94/index.html.

The type and number of configuration-related pages that you see depend on the prompt level that you choose, the SAS tier that you are currently deploying, and the contents of your SAS 9.4 custom order. The following topics provide information for prompts that are specific to SAS Model Manager. For additional information about any of the SAS Deployment Wizard prompts, see the online Help for the wizard page in question.
Select the SAS Application Server

If you are installing SAS Model Manager as an add-on product and have already defined other SAS application servers, the SAS Deployment Wizard asks you to select which application server you want to use. Select an application server other than SASMETA.

Configure the Database

During deployment of SAS Model Manager on SAS 9.4, the SAS Deployment Wizard creates and configures the database tables in the SAS Decision Manager Common Data Server database by default. This database uses the PostgresSQL database management system.

You can use a third-party database server with SAS 9.4. In SAS 9.4, Oracle is the only other third-party database management system that is supported for the SAS Decision Manager database. For information about which versions of the alternative databases are supported, see “Reviewing Third-Party Database Requirements” in SAS Intelligence Platform: Installation and Configuration Guide.

The SAS Deployment Wizard prompts you to enter the information that you gathered when you completed the pre-installation tasks for your database. See “Pre-installation Tasks for SAS Decision Manager Common Data Server” on page 4 and “Pre-installation Tasks for an Oracle Database” on page 5 for more information.

For database-specific information about configuring a database, see SAS Intelligence Platform: Installation and Configuration Guide.

Create and Load Tables through the SAS Deployment Wizard

If you select SAS Decision Manager Common Data Server as the database type, the database tables are automatically created and loaded during the installation and configuration process for the SAS Decision Manager Common Data Server. The default name for the database is dcmdb.

If you select Oracle as the database type, the Automatically create tables and load data check box in SAS Deployment Wizard is enabled. If you want the Oracle database tables to be created and loaded automatically, leave this box selected. If you want to create the tables yourself, then clear the check box, and submit the necessary SQL statements after the wizard finishes running. See “Create Oracle Database Tables” on page 21 for more information.
Chapter 4
Performing Post-installation Tasks

Post-installation Configuration and Verification Steps ........................................ 12
Update User Passwords for Local User Service ................................................. 13
Create Users and Assign Permissions ............................................................... 14
Creating Operating System Accounts for Product Administrators and Users ... 14
  About the User Accounts for SAS Model Manager ........................................ 14
  Using Operating System Groups to Assign Permissions ................................ 14
  Create Windows Operating System Accounts and Groups for Users ............... 15
  Create UNIX Operating System Accounts and Groups for Users .................. 16
Verify WebDAV Folder Permissions for User-Defined Templates ...................... 17
Add a New Workspace Server and Create a SAS Application Server Context ... 19
Extend Support for Double-Byte Characters in Table and Variable Names .......... 21
Create Oracle Database Tables ...................................................................... 21
Verify the Certificate ...................................................................................... 22
Configure Your Deployment for HTTPS ............................................................ 22
Configure Your Deployment for Single Sign-On Web Authentication ................. 23
Configure Users Authenticated by Kerberos for Publishing Models ................. 24
Configure Support for Executable Attachments .............................................. 25
Configure the Dashboard Reports Directory ...................................................... 26
Configuring Model Manager Java Services Options ......................................... 27
  Modify Java Services Options ...................................................................... 27
  Report Options ......................................................................................... 27
  Publish Scoring Options ........................................................................... 28
  Debug Options ......................................................................................... 28
  Valid Variable Name Options ....................................................................... 29
  In-Database Options .................................................................................. 29
  Performance Options .................................................................................. 31
  Factory Miner Options .............................................................................. 33
Configuring the Limitation for the Number of Observations for a Scoring Result Set ................................................................. 34
Modify Log File Settings ................................................................................ 34
  Log4j Configuration File ........................................................................... 34
  Logging Priority Levels ............................................................................. 35
  Log Files ..................................................................................................... 35
Post-installation Configuration and Verification Steps

After you install SAS Model Manager using SAS Software Depot, you must perform additional configuration steps before you can use SAS Model Manager.

1. Verify that all installation and configuration steps in the Instructions.html file have been completed. The Instructions.html file is located in \SAS-configuration-directory\Levn\Documents\SAS. Follow the instructions that are provided in this file.

2. If you used the SAS Deployment Manager to update passwords for the SAS Administrator and SAS Trusted User, then you must also update the users’ passwords for SAS Model Manager 14.2 Local Services before you sign in to the SAS Model Manager web application. For more information, see “Update User Passwords for Local User Service” on page 13.

3. Create application users and assign permissions.

4. Verify that the WebDAV folder permissions are set appropriately to allow authorized users to create and edit user-defined templates.

5. (Optional) SAS Model Manager supports the use of multiple SAS Application Servers to be used as part of a performance definition, a scoring test, or a model retrain definition. To use a SAS Application Server context other than the default SASApp, you must add a new workspace server and create a new SAS Application Server context using the SAS Deployment Wizard. For more information, see “Add a New Workspace Server and Create a SAS Application Server Context” on page 19.

6. (Optional) If you are using the SAS Decision Manager Common Data Server for the SAS Decision Manager database, you can configure the data server for high availability. For instructions, see the technical paper Managing SAS Web Infrastructure Platform Data Server High-Availability Clusters on UNIX.

7. If you are using a locale where national characters or if multi-byte characters are used in table names or variable names, you must extend naming support for double-byte characters. For more information, see “Extend Support for Double-Byte Characters in Table and Variable Names” on page 21.

8. If you cleared the Automatically create tables and load data check box during installation, then you must manually create and load the Oracle database tables for modeling project metadata, including history, job definitions, and job logs. For more information, see “Create Oracle Database Tables” on page 21.

9. (Optional) Configure your deployment for single sign-on web authentication.

10. In order to publish models from SAS Model Manager to a database for scoring, additional configuration steps are required to prepare the database. For more information, see “Preparing a Data Management System for Use with SAS Model Manager” in SAS In-Database Products: Administrator’s Guide.

11. If your system is configured for Kerberos authentication for Hadoop or Teradata, each user must have a valid Kerberos ticket. You must also complete post-installation configuration steps to enable users to publish models from the SAS Model Manager web application. For more information, see “Configure Users Authenticated by Kerberos for Publishing Models” on page 24.
12. Verify that the Certificate Authority certificate is available.

13. (Optional) Configure your deployment to use HTTPS.

14. (Optional) Configure support for executable attachments.

15. (Optional) Add the Visual Analytics: Data Building and Data Management: Lineage roles to the Decision Manager Users group. See “Administering Group and Role Membership” on page 46 for more information. These roles enable users to run SAS Visual Data Builder and view lineage information for rule flows and models.


17. Verify the configuration of the dashboard reports directory on the SAS Workspace Server.

18. Configure the Model Manager Java Services Options.

19. (Optional) Configure the limit for the number of observations for a scoring result set.

20. (Optional) Modify log file settings.

21. (Optional) If you have a license for SAS Factory Miner and want to integrate with SAS Model Manager to be able to register models to the model repository, see SAS Factory Miner: Administration and Configuration.

22. (Optional) If you are using Oracle for the SAS Decision Manager database, you can stop the SAS Decision Manager Common Data Server.

For more information about post-installation tasks, see SAS Intelligence Platform: Installation and Configuration Guide.

---

**Update User Passwords for Local User Service**

If you used the SAS Deployment Manager to update passwords for the SAS Administrator and SAS Trusted User, you must also update the users’ passwords for SAS Model Manager 14.2 Local Services. For more information, see “Update a Managed Password” in SAS Intelligence Platform: Security Administration Guide.

To update the users’ passwords:

1. Log on to SAS Management Console as a SAS administrator.

2. On the Plug-ins tab, navigate to Foundation Services Manager ⇒ SASModelManager14.2 Local Services ⇒ Core.

3. Right-click User Service and select Properties.

4. Click the Service Configuration tab and then click Configuration.

5. Select a user ID from the list and click Edit.

6. Modify the user’s password and click OK.

7. Repeat steps 5 and 6 for each user.

8. Click OK.

9. For changes to take effect, you must restart the web application server, such as SAS [Config-Lev1] WebAppServer SASServer11_1.
Create Users and Assign Permissions

The SAS Deployment Wizard does not create application users by default. The SAS Administrator must create users in SAS Management Console with the appropriate group and role permissions. Make sure that all users are granted the appropriate permissions to the SAS Workspace Server. For more information, see Chapter 6, “Configuring Users, Groups, and Roles,” on page 41.

In a Windows environment, each user or group must be granted permission to the Log on as a batch job local security policy. This permission is required in order to access functionality in the Data category. For more information, see “Create Windows Operating System Accounts and Groups for Users” on page 15.

In a UNIX environment, all SAS Model Manager users must be part of a group that has the appropriate group permissions. For more information, see “Create UNIX Operating System Accounts and Groups for Users” on page 16.

Creating Operating System Accounts for Product Administrators and Users

About the User Accounts for SAS Model Manager

SAS Model Manager provides two types of user accounts:

Product administrator
A SAS Model Manager administrative user is specific to SAS Model Manager. A product administrator account is not the same as a general administrator account, such as the SAS Administrator (sasadm@saspw). These users must have a valid host operating system account, and you must associate that account with a metadata user.

Users of SAS Model Manager
These users must have a valid host operating system account, and you must associate that account with a metadata user through SAS Management Console.

You must create the operating system account for the administrator and for regular user accounts as a post-installation task. For more information, see the following topics:

• “Create Windows Operating System Accounts and Groups for Users”
• “Create UNIX Operating System Accounts and Groups for Users”
• Chapter 6, “Configuring Users, Groups, and Roles,”

Using Operating System Groups to Assign Permissions

Users have different operating system privileges on the SAS Workspace Server. By defining a user group for SAS Model Manager, you can assign all users to the same group and grant the same permissions to all users at one time. All SAS Model Manager users must have Read, Write, and Execute permissions for each environment directory that a user is permitted to use. Users also need permissions to all of the files and directories in an environment directory. The operating system must be configured to grant these permissions when new files and directories are created. The steps that you
follow to do this depend on which operating system groups are defined and your site’s security policies.

**Create Windows Operating System Accounts and Groups for Users**

On the SAS Workspace Server, create an operating system account for the administrator of SAS Model Manager (for example, mdlmgradmin) and all SAS Model Manager users.

If the SAS Workspace Server is running in the Windows operating environment, use one of the following methods to create this operating system account:

- If you are using an LDAP server to manage your users, define the user (for example, `domain\username`) on the Active Directory server.
- If you are working on a local machine, complete these steps to create this user account:
  1. Right-click the Computer icon on your desktop and select *Manage*. The Computer Management window appears.
     
     *Note:* If you are creating users on a server, you can use the Server Manager.
  2. In the left navigation pane, expand the *Local Users and Groups* node. The *Users* and *Groups* nodes appear.
  3. Right-click the *Users* node and select *New User*. The *New User* window appears.
  4. In the *New User* window, complete these tasks:
     - Specify a user name and password.
     - Clear the *User must change password at next logon* check box.
     - Select the *User cannot change password* check box.
     - Select the *Password never expires* check box.
     - Click *Create*.
  5. Click *Close* to close the *New User* dialog box.
  6. If you want to add the users that you created to a group, perform the following steps:
     a. Right-click the *Groups* node in the Computer Management window, and select *New Group*.
     b. Click *Add*. Enter the user names, separated by semicolons, and click *Check Names*.
     c. Click *OK*.
  7. Assign the security policy of *Log on as batch job* for each user or group.
     a. Select *Start* ⇒ *Control Panel* ⇒ *System and Security* ⇒ *Administrative Tools* ⇒ *Local Security Policy*.
     b. From the Local Security Policy window, expand the *Local Policies* node and select *User Rights Assignment*. Then double-click the *Log on as batch job* policy.
Create UNIX Operating System Accounts and Groups for Users

**Conditions for the User Group**
If you are working in a UNIX operating environment, the following conditions must be met:

- A group of users is created for the UNIX operating environment. The logon IDs for each user must be in this group. The group must also include any user who might run code that is created by SAS Model Manager in a SAS session.

- Users can be members of multiple groups, but the SAS Model Manager group is the primary group for each user.

- The SAS scripts are updated to grant permissions to the SAS Model Manager users on the SAS Workspace Server. For more information, see “Update the SAS Scripts to Grant Permissions to the User Group” on page 16.

- Each environment directory has the correct ownership, and the user group has Read, Write, and Execute permissions.

**Update the SAS Scripts to Grant Permissions to the User Group**
Using the `umask` option, you can grant permissions to users on a conditional basis if the user is part of the SAS Model Manager user group.

*Note:* This example might require changes to fit your server configuration. In particular, this example could result in changed permissions on other SAS files, such as OLAP cubes. For example, if you are working with multiple UNIX groups and have a SAS OLAP Server, you must ensure that the account under which the SAS OLAP Server runs has Read and Execute permissions to OLAP files.

To set these permissions:


2. Enter the configuration information for your operating environment. Here is the general format of this code:

   ```
   CMD=<your-operating-system-path>
   CURR_GID=`eval $CMD -g`
   GID=<solution-group-id>
   if [$CURR_GID -eq $GID]; then umask 002 fi
   ```

   1. In the `CMD=<your-operating-system-path>`, specify the full path on your server where the ID command is stored. You can get this information by entering a `which id` or `whence id` command on your console.

   2. In the `GID=<solution-group-id>`, specify the group ID. Type `id` on your console to get the GID and UID information.

   3. A value of 002 is recommended for the `umask` option.

   Here are code examples for each UNIX environment where SAS Model Manager is supported:
Verify WebDAV Folder Permissions for User-Defined Templates

During the SAS Model Manager installation process, the ModelManager, sasfolders, and sasdav WebDAV folders are automatically created with default permissions on the SAS Content Server. If you migrated or upgraded from a previous release, the WebDAV folder permissions should be preserved. Use the SAS Content Server Administration Console (SCS Admin Console) to control access to an existing WebDAV folder.

Here are the default permissions for a new installation of SAS Model Manager for the folder /ModelManager/ConfigTemplates/ext:

<table>
<thead>
<tr>
<th>Group</th>
<th>Permissions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>mdlmgrusers</td>
<td>Read</td>
<td>Model Manager Users group</td>
</tr>
<tr>
<td>mdlmgradminusers</td>
<td>Read, Write, and Delete</td>
<td>Model Manager Administrator Users group</td>
</tr>
</tbody>
</table>
In order to create new model and report templates, as well as edit existing user-defined templates, users must have Read and Write permissions to the `/ModelManager/ConfigTemplates/ext` folder.

To verify or modify the folder permissions for the `ext` folder:

1. Access the SAS Content Server Administration console by entering the following URL in your web browser and substituting the server name and port number of your SAS Content Server: [http://server-name:port/SASContentServer/dircontents.jsp](http://server-name:port/SASContentServer/dircontents.jsp).

   **Note:** The default port number for the SAS Web Application Server is 7980 for a UNIX environment and 80 for a Windows environment.

2. Sign in to the console as an unrestricted user (for example, SAS Administrator). The SCS Admin Console window appears.

3. Click `ModelManager` ➔ `ConfigTemplates`.

4. Click the permissions icon for the `ext` folder. The Permissions page appears.

5. Modify the permissions for the `mdlmgradusers` principal to give Write permissions by changing the `WRITE` and `INHERIT WRITE` permissions to `Yes`.

   **Note:** It is recommended that you give Delete permissions only to the `mdlmgradminusers` group.
Add a New Workspace Server and Create a SAS Application Server Context

SAS Model Manager on SAS 9.4 provides support for multiple SAS Application Servers that can be used when specifying a performance definition, a scoring test, or a model retrain definition.

To add a new workspace server to your SAS Model Manager installation:

1. On the machine where the SAS Application Server was installed, start the SAS Deployment Wizard from the highest-level directory in your SAS Software Depot using the command file that is appropriate for your operating system. On Windows systems that command file is setup.exe. For UNIX systems, use setup.sh.

2. Select Install SAS Software. Click Next.

3. Select Perform a Planned Deployment, deselect Install SAS Software, and select only Configure SAS Software. Click Next.

4. You must use the same deployment plan that was used when you installed the original server component. This example uses one of the standard deployment plans. Choose Select a standard deployment plan, and select the appropriate Model Mgr plan for your machine configuration. Click Next.

5. Select the server machine on which you want to configure the SAS Application Server. Click Next.

6. On the Checking System page, click Next.

7. On the Select Configuration Prompting Level page, select Typical. Click Next.

8. On the Specify Configuration Information page, you must select the same options as your original installation. For this example, use the default settings. Click Next.

9. The SAS Deployment Wizard warns you that the configuration directory and level that you specified contain existing files. Select Yes.


11. On the Local Machine Name page, accept the default settings. Click Next.

12. On the Migration Information page, no migration should be performed. Click Next.


14. On the SAS Metadata Server page, accept the default settings. Verify that the SAS Metadata Server and port are valid. Click Next.

15. On the Deployment Accounts: Type of Accounts page, select Use SAS internal accounts when appropriate. Click Next.

16. On the SAS Internal Account: Unrestricted Administrator page, enter the same password that was used in the original installation. Click Next.

17. On the Deployment Accounts: First User page, there is no need to set up a first user ID. Click Next.
18. On the Create SAS Application Server Context page, select **Create a SAS Application Server Context**. Click **Next**.

19. On the SAS Application Server: Server Context page, enter **SASApp_2** in the field **SAS Application Server Context Name**. Click **Next**.

20. On the SAS Server Dependencies page, confirm that the value of **SAS Application Server Context** is **SASApp_2**. Click **Next**.

21. On the SAS Workspace Server page, enter the workspace server port. This example uses the default value, 8592. Click **Next**.

22. Select the deployment summary and click **Start**. When the SAS Deployment Wizard is finished, note the additional resources and click **Finish**.

Next you must configure the Job Execution Service and restart the SAS web application servers.

1. Run SAS Management Console and select the **Plug-ins** tab. Select **SAS Application Management ⇒ Configuration Manager ⇒ SAS Application Infrastructure ⇒ Web Infra Platform Services 9.4 ⇒ JobExecutionService**.

2. Right-click **JobExecutionService** and select **Properties**.

3. Select the **Settings** tab in the **JobExecutionService Properties** window and locate the **Configure Execution Queues from Available Server Contexts** section.

4. Select the new server (for example, **SASApp_2**). Then move it to the **Selected** list.

5. In the **SASApp_2 Execution Queue Properties** section, clear **Enable for interactive execution?**.

6. Click **OK**.

7. Restart SAS servers, including the SAS Metadata Server and SAS Web Application Servers. For example, in a default Windows installation this can be done for Services from the Windows Management Console by restarting the Service name, such as **SAS [Config-Lev1] WebAppServer SASServer11_1**.

To verify your new server from SAS Model Manager:

1. Sign in to SAS Model Manager.

2. Create a scoring test that uses the new SAS Application Server context.

3. Execute the scoring test.

For more information, see:

- “Managing SAS Application Servers” in *SAS Intelligence Platform: Application Server Administration Guide*
- “Managing Workspace Servers and Stored Process Servers” in *SAS Intelligence Platform: Application Server Administration Guide*
- “Add a New Logical Server in an Existing SAS Application Server” in *SAS Intelligence Platform: Application Server Administration Guide*
- “Job Execution Service” in *SAS Intelligence Platform: Middle-Tier Administration Guide*
Extend Support for Double-Byte Characters in Table and Variable Names

If your locale contains national characters or multi-byte characters, you can extend naming convention support for tables that have a table name or that contain variable names with double-byte characters. After you extend support, you can register these tables in the Tables category in SAS Model Manager. (Select Data → Tables.) You can view these tables and use them to create summary tables. Tables with extended support for double-byte characters can also be used in models, model projects, and model portfolios, as well as in their associated tasks.

To enable support for these types of tables:

1. Add the following lines to the autoexec_usermods.sas file.
   ```sas
   options validmemname=extend;
   options validvarname=any;
   ```
   For Windows environments, this file is located in the \SAS-configuration-directory\Lev\SASApp\WorkspaceServer\ directory.
   For UNIX environments, this file is located in the /SAS-configuration-directory/Lev/SASApp/WorkspaceServer/ directory.

2. Set the Valid Variable Name Options setting to Yes in SAS Management Console. For more information, see “Valid Variable Name Options” on page 29.

Note: Although the VALIDMEMNAME=EXTEND and VALIDVARNAME=AIGN system options extend support for double-byte characters, blanks, and special characters, SAS Model Manager does not fully support these options. Special characters and blanks in table names or variable names are not supported.

See Also

- “VALIDMEMNAME= System Option” in SAS System Options: Reference
- “VALIDVARNAME= System Option” in SAS System Options: Reference

Create Oracle Database Tables

When you ran the SAS Deployment Wizard, the Automatically create tables and load data check box was selected by default for the SAS Decision Manager database. (See “Create and Load Tables through the SAS Deployment Wizard” on page 10.) If you cleared the Automatically create tables and load data check box and you do not have an existing database instance, you must run the SQL scripts to create and load the tables.

Run the CreateMMTables.sql script in order to create and load the model tables. The script is located in SASHome\SASModelManagerMidTier\14.2\Config\Deployment\Content\dbscript\oracle\.
**Verify the Certificate**

During installation and configuration of SAS 9.4, the SAS Deployment Wizard enables you to configure the SAS Web Server to use HTTPS and Secure Sockets Layer (SSL) certificates automatically. Verify that the Certificate Authority certificate is available to the trust store for the browser and Java clients such as SAS Workflow Studio and SAS Management Console. For more information, see the Instructions.html file in the directory `\SAS-configuration-directory\Lev\Documents`, and “Validating the Secured Middle-Tier Environment” in *SAS Intelligence Platform: Middle-Tier Administration Guide*.

If you did not use the SAS Deployment Wizard to configure the SAS Web Server to use HTTPS and SSL certificates, you can configure it manually. For more information, see “Configuring SAS Web Server Manually for HTTPS” in *SAS Intelligence Platform: Middle-Tier Administration Guide*.

The communication path between SAS Web Server and SAS Web Application Server uses HTTP by default. If you configured the SAS Web Server to use HTTPS by using the SAS Deployment Wizard, you must complete additional steps in order to use HTTPS between SAS Web Server and SAS Web Application Server. For more information, see “Configuring SAS Web Application Server to Use HTTPS” in *SAS Intelligence Platform: Middle-Tier Administration Guide*. If you configure the SAS Web Application Server to use HTTPS, see “Configure Your Deployment for HTTPS” on page 22 for additional instructions.

**Configure Your Deployment for HTTPS**

The steps listed in “Configuring SAS Web Application Server to Use HTTPS” in *SAS Intelligence Platform: Middle-Tier Administration Guide* change the communication path between the SAS Web Server and SAS Web Application Server to use HTTPS. If you completed those steps and configured the communication path to use HTTPS, then you must also configure the SAS Web Application Server to use HTTPS.

To configure the SAS Web Application Server to use HTTPS:

1. Edit the setenv file for your operating environment.

<table>
<thead>
<tr>
<th>Environment</th>
<th>File</th>
<th>Directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>UNIX</td>
<td>setenv.sh</td>
<td>/SAS-configuration-directory/Lev/\Web/</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WebAppServer/SASServer7_1/bin</td>
</tr>
<tr>
<td>Windows</td>
<td>setenv.bat</td>
<td>\SAS-configuration-directory\Lev/\Web</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WebAppServer\SASServer7_1\bin</td>
</tr>
</tbody>
</table>

Add the following option to the JVM_OPTS line:
Configure Your Deployment for Single Sign-On Web Authentication

SAS 9.4 web applications can be configured to use single sign-on web authentication. For more information, see the steps in “Web Authentication” in SAS Intelligence Platform: Middle-Tier Administration Guide. After you complete those steps, an additional configuration is needed.

To configure SAS Model Manager to use single sign-on web authentication:

1. Edit the setenv file for your operating environment.

<table>
<thead>
<tr>
<th>Environment</th>
<th>File</th>
<th>Directory</th>
</tr>
</thead>
</table>
| UNIX        | setenv.sh | /SAS-configuration-directory/Lev
Web/WebAppServer/SASServer11_1/bin |
| Windows     | setenv.bat | /SAS-configuration-directory/Lev\Web/ WebAppServer\SASServer11_1/bin |

Add the following option to the JVM_OPTS line:

-DMMSingleSignOn=on

2. In Windows environments, edit the wrapper.conf file in the \SAS-configuration-directory\Lev\Web\WebAppServer\SASServer11_1\conf directory.

Add the following line in the Java Additional Parameters section:

wrapper.java.additional.n=-DMMSingleSignOn=on

The number \( n \) is the next number in the sequence of the wrapper parameters.

Note: If you are configured to use single sign-on web authentication by Kerberos for Teradata or Hadoop, you must add options to be able to publish models from SAS Model Manager. Other database management systems are not supported for single sign-on authentication at this time. Before continuing to the next step, see “Configure Users Authenticated by Kerberos for Publishing Models” on page 24.

*Note:* The option is needed only on SASServer11; it is not needed on SASServer7.

---

## Configure Users Authenticated by Kerberos for Publishing Models

To use Kerberos authentication, each SAS Model Manager user must have a valid Kerberos ticket to access SAS Model Manager. Users who are configured to use single sign-on web authentication by Kerberos for Teradata or Hadoop must also perform additional post-installation configuration steps so that they can publish models to a Teradata or a Hadoop Distributed File System (HDFS) from SAS Model Manager:

You must also configure your deployment to use single sign-on web authentication by Kerberos for Teradata or Hadoop.

1. Edit the setenv file for your operating environment.

<table>
<thead>
<tr>
<th>Environment</th>
<th>File</th>
<th>Directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>UNIX</td>
<td>setenv.sh</td>
<td><code>/SAS-configuration-directory/Levn/Web/WebAppServer/SASServer11_1/bin</code></td>
</tr>
<tr>
<td>Windows</td>
<td>setenv.bat</td>
<td><code>\SAS-configuration-directory\Levn\Web\WebAppServer\SASServer11_1\bin</code></td>
</tr>
</tbody>
</table>

Add the following options to the JVM_OPTS line:

- `Dmm.kerberized.hadoop=on`
- `Dmm.kerberized.teradata=on`

*Note:* You can enable one or both options.

2. In Windows environments, edit the wrapper.conf file in the `\SAS-configuration-directory\Levn\Web\WebAppServer\SASServer11_1\conf` directory.

Add the following lines in the Java Additional Parameters section:

```java
wrapper.java.additional.n=-Dmm.kerberized.hadoop=on
wrapper.java.additional.n=-Dmm.kerberized.teradata=on
```

The number `n` is the next number in the sequence of the wrapper parameters.

*Note:* You can enable one or both options.


*Note:* The option is needed only on SASServer11; it is not needed on SASServer7.
Configure Support for Executable Attachments

For SAS 9.4M6, you can configure SAS Model Manager to allow executable attachments for models, projects, and portfolios. This configuration applies only to the Attachments page of an object. Executable attachments cannot be attached to a topic on the Comments page of an object.

To configure executable attachments:

1. Edit the setenv file for your operating environment.

<table>
<thead>
<tr>
<th>Environment</th>
<th>File</th>
<th>Directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>UNIX</td>
<td>setenv.sh</td>
<td>/SAS-configuration-directory/Levn/Web/WebAppServer/SASServer11_1/bin</td>
</tr>
<tr>
<td>Windows</td>
<td>setenv.bat</td>
<td>\SAS-configuration-directory\Levn\Web\WebAppServer\SASServer11_1\bin</td>
</tr>
</tbody>
</table>

Add the following option to the JVM_OPTS line:

-DallowExecutableAttachments=on

2. In Windows environments, edit the wrapper.conf file in the \SAS-configuration-directory\Levn\Web\WebAppServer\SASServer11_1\conf directory.

Add the following line in the Java Additional Parameters section:

wrapper.java.additional.n=-DallowExecutableAttachments=on

The number \(n\) is the next number in the sequence of the wrapper parameters.


*Note:* The option is needed only on SASServer11; it is not needed on SASServer7.

Here are the valid executable file types when the configuration for executable attachments is enabled:

- ade  - csh  - jse  - maw  - msh2xml  - ps1xml  - vb
- adp  - der  - ksh  - mda  - msi  - ps2  - vbe
- app  - exe  - lnk  - mdb  - msp  - ps2xml  - vbp
- asp  - fxp  - mad  - mde  - mst  - psc1  - vbs
- bas  - gadget  - maf  - mdt  - ops  - psc2  - vsmacros
- bat  - hlp  - mag  - mdw  - osd  - reg  - vsw
- cer  - hpj  - mam  - mdz  - pcd  - scf  - ws
- chm  - hta  - maq  - msc  - pif  - scr  - wsc
- cmd  - ing  - mar  - msh  - plg  - sct  - wsf
- cnt  - ins  - mas  - msh1  - prf  - shb  - wsh
- com  - isp  - mat  - msh2  - prg  - shs  - xnk
- cpl  - its  - mau  - mshxml  - pst  - tmp
Configure the Dashboard Reports Directory

In SAS Model Manager, the dashboard reports directory is configured during installation. The default directory is `\SAS-configuration-directory\Lev\AppData\SASModelManager14.2\Dashboard`.

**Note:** When the SAS Web Application Server and the SAS Workspace Server are located on different physical machines, the Software Deployment Wizard creates a directory on the SAS Web Application Server machine and uses that value for the `App.DashboardDir` property value. You must create a directory that is accessible by the SAS Workspace server, and the SAS Model Manager users must have permissions to that directory.

To configure a different directory to store the SAS Model Manager dashboard reports:

1. Connect to the SAS Workspace Server.
2. Create a new directory (for example, `C:\Dashboard`).
   **Note:** The directory must be located on the SAS Workspace Server or on a network drive that is accessible by the SAS Workspace Server. Do not include special characters or spaces in the name of the directory.
3. Grant user permissions for the new directory. For example, perform the following tasks:
   - Grant Full Control permission to users who need to create subdirectories, write content, or delete content. This type of user includes a user who you will add (using SAS Management Console) to the Model Manager Administrator Users group or a user who is a SAS administrator.
   - Grant Read, Write, and Execute permissions to users who need to create performance indicators and execute dashboard reports. This type of user includes a user who you will add (using SAS Management Console) to the Model Manager Advanced Users group.
   - Grant Read and Execute permissions to users who need only to view the dashboard reports. This type of user includes a user who you will add (using SAS Management Console) to the Model Manager Users group.
   **Note:** In a UNIX environment all SAS Model Manager users must be part of a group that has the appropriate group permissions. For more information, see “Create UNIX Operating System Accounts and Groups for Users” on page 16 and Chapter 6, “Configuring Users, Groups, and Roles,” on page 41.
4. From SAS Management Console, expand the **Application Management** node on the **Plug-ins** tab.
5. Select and expand **Configuration Manager ⇓ SAS Application Infrastructure ⇓ Enterprise Decision Manager 3.2.**

6. Right-click **Model Manager JavaSvcs 14.2** and select **Properties**.
7. (optional) Click the **Settings** tab and then select **Report Options**. Use this setting to specify the styles that are available when a user generates dashboard reports, and to enable the indicator override option for defining dashboard report indicators. When you use the indicator override configuration, indicators with conditions are available
when you add dashboard report indicators using SAS Model Manager. For more information, see “Report Options” on page 27.

8. Click the Advanced tab to modify the application dashboard directory. Change the property value for App.DashboardDir to the directory path that was configured.

9. Click OK.

10. For changes to take effect, you must restart the web application server.

---

**Configuring Model Manager Java Services Options**

The **Model Manager Java Services Options** setting in SAS Management Console enables you to modify model management configurations. The configurations can be modified for reporting, for metadata tables usage when publishing a scoring function, for SAS code debugging, SAS system options, In-database connection and publishing options, and performance options for the SAS High-Performance Analytics procedures.

**Modify Java Services Options**

1. Log on to SAS Management Console as a SAS administrator.

2. On the **Plug-ins** tab, navigate to **Application Management** ⇒ **Configuration Manager** ⇒ **SAS Application Infrastructure** ⇒ **Enterprise Decision Manager 3.2**.

3. Right-click **Model Manager JavaSvcs 14.2** and select **Properties**.

4. Click the **Settings** tab and then select **Model Manager Java Services**.

5. Select one of the following options to view and configure the available settings.

   - **Report Options**
   - **Publish Scoring Options**
   - **Debug Options**
   - **Valid Variable Name Options**
   - **In-Database Options**
   - **Performance Options**
   - **Factory Miner Options**

6. Click **OK**.

7. For changes to take effect, you must restart the web application server.

---

**Report Options**

The **Report Options** setting in SAS Management Console enables you to modify the SAS Model Manager configurations for the dashboard reports, for model retrain reports, and for performance monitoring. These reports are available on the **Reports** page for a project in SAS Model Manager.

To modify the report options setting:
1. Specify the formats that are available when a user creates model retrain reports. The default values are RTF, PDF, and HTML. You can remove any of the default values so that they are not available in SAS Model Manager.

2. Specify the report styles that are available when a user creates the model retrain reports and dashboard reports. You can add or remove SAS styles. The default values are SAS default, Seaside, Meadow, and Harvest. For more information about SAS styles, see “Style Templates” in SAS Output Delivery System: User’s Guide.

3. Specify a value for a random seed to be used by performance definitions for models that have an interval target. The default value is 12345. The random seed is the initial seed for the random number generator used for sampling the input data set.

4. Specify a value for the sample size that is used by performance definitions for models that have an interval target. The default value is 1000. The sample size for models with an interval target is the number of observations from the input data set.

5. Specify a value for the sample size that is used by performance definitions for characteristic and stability analysis. The default value is 10000. The sample size for characteristic and stability analysis is the number of observations from the input data set.

6. Select Yes or No to specify whether to use the temporary tables on the High-Performance Analytics appliance for performance monitoring. The default is Yes.

7. Specify a value for the correlation coefficient (rho) that is used by the binomial test to estimate the probability of default (PD) levels. The default value is 0.04.

### Publish Scoring Options

The Publish Scoring Options setting enables you to indicate that the metadata tables be populated in the target database when publishing a scoring function. The default is Yes. During the installation and configuration process of the database, the metadata tables must be created in the database if this setting is set to Yes. If you plan to use only the SAS Embedded Process publish method to publish scoring model files, this setting can be ignored, and you do not need to create the metadata tables during the database configuration process.

For information about the database configurations, see “Preparing a Data Management System for Use with SAS Model Manager” in SAS In-Database Products: Administrator’s Guide. For more information about publishing models to a database, see “Publishing Models to a Database or Hadoop” in SAS Model Manager: User’s Guide.

### Debug Options

The Debug Options setting enables you to use the debug options when executing SAS code within SAS Model Manager. The default value is No.

However, the Debug Options setting does not work for scoring tests, performance definitions, and model retrain definitions. To enable debug options with scoring tests, you must add the following line of code to the appserver_autoexec_usermods.cfg file in the \SAS-configuration-directory\Lev\SASApp\WorkspaceServer\ directory:

```plaintext
options mprint symbolgen notes;
```

**Note:** You can also add this code using the Edit Start-up Code feature in SAS Model Manager.
**Valid Variable Name Options**

The VALIDVARNAME= system option specifies the rules for valid SAS variable names that can be created and processed during a SAS session. The **Valid Variable Name Options** setting enables you to set the VALIDVARNAME system option to ANY when executing SAS code. To do this, you select Yes. The default value is No.

However, the **Valid Variable Name Options** setting does not work for scoring tests, performance monitoring, or retraining jobs. To use the VALIDVARNAME system option with these features, you must add the following line of code to the autoexec_usermods.sas file in the \SAS-configuration-directory\Lev\SASApp\WorkspaceServer\ directory:

```sas
options validvarname=any; 
```

*Note:* You can also add this code using the Edit Start-up Code feature in SAS Model Manager. For more information, see “Edit Start-Up Code” in *SAS Model Manager: User’s Guide.*

When the VALIDVARNAME system option is set to V7, variable names with letters of the Latin alphabet, numerals, or underscores are valid. If you use any other characters, then you must express the variable name as a name literal, and you must also set VALIDVARNAME=ANY. If the name includes either the percent sign (%) or the ampersand (&), then you must use single quotation marks in the name literal in order to avoid interaction with the SAS Macro Facility. For more information, see “VALIDVARNAME= System Option” in *SAS System Options: Reference.*

*Note:* You must have set the VALIDVARNAME system option to ANY in order to use PMML models that were created using SAS Enterprise Miner in scoring tests, performance monitoring, and reporting within SAS Model Manager.

**In-DATABASE Options**

The **In-DATABASE Options** settings enables you to specify the publish type, database connection settings, and publish settings that are used when publishing models to a database using SAS Model Manager.

To modify the settings for the in-database options:

1. Select a method to publish models to the database for scoring. The default publish type is the **SAS Embedded Process** publish method.

2. Select a database type.

3. Specify values for database settings that are required to publish to the selected database type.
Here are the available database settings according to the publish method and database type:

<table>
<thead>
<tr>
<th>Database Settings</th>
<th>SAS Embedded Process</th>
<th>Scoring Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server name</td>
<td>Teradata</td>
<td>Teradata</td>
</tr>
<tr>
<td></td>
<td>Oracle</td>
<td>Netezza</td>
</tr>
<tr>
<td></td>
<td>Netezza</td>
<td>Greenplum</td>
</tr>
<tr>
<td></td>
<td>Greenplum</td>
<td>DB2</td>
</tr>
<tr>
<td></td>
<td>DB2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hadoop</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SAP HANA</td>
<td></td>
</tr>
<tr>
<td>HDFS directory path</td>
<td>Hadoop</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Database name or instance number</td>
<td>Teradata</td>
<td>Teradata</td>
</tr>
<tr>
<td></td>
<td>Oracle</td>
<td>Netezza</td>
</tr>
<tr>
<td></td>
<td>Netezza</td>
<td>Greenplum</td>
</tr>
<tr>
<td></td>
<td>Greenplum</td>
<td>DB2</td>
</tr>
<tr>
<td></td>
<td>DB2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SAP HANA</td>
<td></td>
</tr>
<tr>
<td>User ID</td>
<td>Teradata</td>
<td>Teradata</td>
</tr>
<tr>
<td></td>
<td>Oracle</td>
<td>Netezza</td>
</tr>
<tr>
<td></td>
<td>Netezza</td>
<td>Greenplum</td>
</tr>
<tr>
<td></td>
<td>Greenplum</td>
<td>DB2</td>
</tr>
<tr>
<td></td>
<td>DB2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hadoop</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SAP HANA</td>
<td></td>
</tr>
<tr>
<td>Server user ID</td>
<td>Not applicable</td>
<td>DB2</td>
</tr>
<tr>
<td>Schema</td>
<td>Oracle</td>
<td>Greenplum</td>
</tr>
<tr>
<td></td>
<td>Greenplum</td>
<td>DB2</td>
</tr>
<tr>
<td></td>
<td>DB2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SAP HANA</td>
<td></td>
</tr>
</tbody>
</table>

4. Specify to use the model manager table when publishing. The default value is **No**. When you are publishing the scoring model files to a database using the SAS Embedded Process publish method, the files are by default stored in the table `sas_model_table`. If the **Use model manager table** value is set to **Yes**, the scoring model files are stored in the table `sas_mdlmgr_ep`. These tables are located in the target database. This setting enables users to separate the SAS Model Manager scoring model files from the SAS model scoring files when using the SAS Embedded Process publish method.
Note: The sas_mdlmgr_ep table must be created before setting this option to Yes. For more information, see “Configuring a Database” in SAS In-Database Products: Administrator's Guide.

5. Specify to force the republish of model scoring files by default when using the SAS Embedded Process publish type. The default value is No. If you set this setting to Yes, then the Replace scoring files that have the same publish name option in the Publish Models window in SAS Model Manager is selected by default.

6. Select the default format of the model publish name when using the SAS Embedded Process publish method. The format selected determines the value that appears for the publish name in the Publish Models window in SAS Model Manager. The scoring function publish method publish name defaults to the model name.

7. Specify a directory path to store the temporary scoring files. If a value is not specified, the SAS work directory is used by default. However, if the directory is not specified and you select the Display detailed log messages option when publishing to a database the SASUSER directory is used.

For information about the database configurations, see “Preparing a Data Management System for Use with SAS Model Manager” in SAS In-Database Products: Administrator's Guide. For more information about publishing models to a database, see “Publishing Models to a Database or Hadoop” in SAS Model Manager: User's Guide.

Performance Options

The Performance Options setting contains the performance parameters for the PERFORMANCE statement to use the SAS High-Performance Analytics procedures. Currently only the Teradata and Greenplum database types support SAS High-Performance Analytics.

The PERFORMANCE statement defines performance parameters for multithreaded and distributed computing, passes variables about the distributed computing environment, and requests detailed results about the performance characteristics of a high-performance analytics procedure.

The following performance options can be specified for the PERFORMANCE statement.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commit</td>
<td>Specifies an integer to request that the High-Performance Analytics procedure writes periodic updates to the SAS log.</td>
<td>10000</td>
</tr>
<tr>
<td>CPU count</td>
<td>Specifies how many processors the procedure should assume are available on each host in the computing environment. You can enter the value of ACTUAL, or enter an integer between 1 and 256.</td>
<td>ACTUAL</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>Default Value</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Database server</td>
<td>Specifies the name of the server for the database as defined through the hosts file and as used in the LIBNAME statement.</td>
<td></td>
</tr>
<tr>
<td>Details</td>
<td>Requests a table that shows a timing breakdown of the procedure steps.</td>
<td>No</td>
</tr>
<tr>
<td>Timeout</td>
<td>Specifies the time-out in seconds for a High-Performance Analytics procedure to wait for a connection to the appliance and establish a connection back to the client.</td>
<td>120</td>
</tr>
<tr>
<td>Host name</td>
<td>Specifies the name of the appliance. If a value for the Host option is specified, it overrides the value of the grid host environment variable.</td>
<td></td>
</tr>
<tr>
<td>Installation directory</td>
<td>Specifies the name of the directory in which the High-Performance Analytics shared libraries are installed on the appliance.</td>
<td></td>
</tr>
<tr>
<td>Install location</td>
<td>Specifies the name of the directory in which the High-Performance Analytics shared libraries are installed on the appliance. If a value is specified for the Installation directory option, it overrides this option.</td>
<td></td>
</tr>
<tr>
<td>Number of nodes</td>
<td>Specifies the number of nodes in the distributed computing environment, provided that the data is not processed alongside the database. You can enter an integer or you can specify a value of ALL if you want to use all available nodes on the appliance without oversubscribing the system.</td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>Default Value</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Number of threads</td>
<td>Specifies the number of threads for analytic computations. This option overrides the SAS system option THREADS</td>
<td>NOTHREADS. If you do not specify a value for this option, the number of threads are determined based on the number of CPUs on the host on which the analytic computations execute.</td>
</tr>
<tr>
<td>Grid host</td>
<td>Specifies the host name for the grid. If a value for the Host option is specified, it overrides the value of the grid host environment variable.</td>
<td></td>
</tr>
<tr>
<td>Grid RSH command</td>
<td>Specifies the command to run a remote shell.</td>
<td></td>
</tr>
<tr>
<td>Grid reply host</td>
<td>The host name of the client node to which the grid connects.</td>
<td></td>
</tr>
<tr>
<td>Grid port range</td>
<td>Specifies the range of parts that are permitted by the firewall.</td>
<td></td>
</tr>
<tr>
<td>Grid path</td>
<td>Specifies the local directory path for the grid node.</td>
<td></td>
</tr>
<tr>
<td>Grid mode</td>
<td>Specifies whether the HPFORECAST procedure runs in symmetric (SYM) mode or asymmetric (ASYM) mode. The default is symmetric (GRIDMODE=SYM).</td>
<td>Symmetric</td>
</tr>
</tbody>
</table>

For more information about High-Performance Analytics, see *SAS High-Performance Analytics Server: User's Guide*.

**Factory Miner Options**

If SAS Factory Miner and SAS Model Manager are licensed at your site, you can register projects segments and models from SAS Factory Miner to the SAS Model Manager model repository. The project segments and models are created within a portfolio. Use the **Automatically set champion** setting to automatically set the project champion in the model repository when a model is set as the champion for a project segment in SAS Factory Miner. The default value is **No**. For information about integrating SAS Factory Miner with SAS Model Manager, see *SAS Factory Miner: Administration and Configuration*.
Configuring the Limitation for the Number of Observations for a Scoring Result Set

When a scoring test is added on the Scoring page of a project in SAS Model Manager, and the Type field is set to Test, you can use SAS Management Console to limit the number of observations that a scoring result set can contain.

To configure a limitation for the number of observations:

1. From SAS Management Console, expand the Application Management node on the Plug-ins tab.
2. Select and expand Configuration Manager ⇨ SAS Application Infrastructure ⇨ Enterprise Decision Manager 3.2.
4. Click the Advanced tab. Change the property value for App.TableObsLimitation to limit the number of observations in the scoring result set. The default value of 0 indicates that there is no limit to the number of observations that a scoring result set can contain.
5. Click OK. The value that you specified now appears in the Number of Observations result set property when you create a scoring test using SAS Model Manager.

Modify Log File Settings

Log4j Configuration File

SAS Model Manager uses log4j to perform logging. When SAS Model Manager starts, the log4j configuration file for the web application is read from SAS-configuration-directory\Lev\Web\Common\LogConfig \SASModelManager-log4j.xml. This file is a standard log4j configuration file.

You should not change the existing categories or root logger in a configuration file unless you are instructed to do so by SAS Technical Support.

Note: If you make any changes to the log4j configuration file, you must restart SASServer11 for the changes to take effect.
Logging Priority Levels

You can change the logging priority levels in a log configuration file if needed.

Table 4.1 Logging Priority Levels

<table>
<thead>
<tr>
<th>Priority</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DEBUG</td>
<td>The most verbose logging level. This level displays information that is most useful for debugging an application. SAS Model Manager should run under this priority only for capturing additional log information. This priority level is not an acceptable priority level for the day-to-day operation of SAS Model Manager.</td>
</tr>
<tr>
<td>INFO</td>
<td>Verbose logging level. This level displays messages that highlight the progress of an application. SAS Model Manager should run under this priority only for capturing additional log information. This priority level is not an acceptable priority level for the day-to-day operation of SAS Model Manager.</td>
</tr>
<tr>
<td>WARN</td>
<td>Restrictive logging. This level displays information about potentially harmful situations and is an acceptable priority for the day-to-day operation of SAS Model Manager.</td>
</tr>
<tr>
<td>ERROR</td>
<td>The most restrictive logging level. This level displays error events and is an acceptable priority for the day-to-day operation of SAS Model Manager.</td>
</tr>
</tbody>
</table>

Log Files

SAS Model Manager writes information to the following log files:

SASModelManager14.2.log contains messages from SAS Model Manager
SASDecMgrCommon3.2.log contains messages from the Workflow and Data plug-ins
SASDecMgrShell3.2.log contains general messages from the Shell

By default, the application writes the SAS Decision Manager log files to SAS-configuration-directory\Lev\Web\Logs\SASServer7_1\. The SASModelManager14.2.log file is written to SAS-configuration-directory\Lev\Web\Logs\SASServer11_1\. You can change the location of these log files in the configuration file. Changes to the configuration file take effect when the middle-tier application server is restarted. See “Administering Logging for SAS Web Applications” in SAS Intelligence Platform: Middle-Tier Administration Guide for more information about this configuration file.

SAS Model Manager creates new log files each day. For information about logging configurations, see “Modifying Your Server Logging Configurations” in SAS Intelligence Platform: System Administration Guide.
**Turn on SQL Logging**

To turn on SQL logging and write SQL parameter values for each query to the log file, add the following categories to the log4j.xml configuration file:

```xml
<category additivity="false" name="org.hibernate.type">
  <priority value="TRACE"/>
  <appender-ref ref="SAS_FILE"/>
</category>

<category additivity="false" name="org.hibernate.SQL">
  <priority value="DEBUG"/>
  <appender-ref ref="SAS_FILE"/>
</category>
```
Chapter 5
Performing Upgrade Tasks

Overview of the Upgrade Process

Beginning with SAS Model Manager 14.1, the software includes SAS Decision Manager Common components and is integrated with SAS Lineage as well. If you are upgrading from SAS Model Manager 14.1 to 14.2, only one pass of the SAS Deployment Wizard is needed. If you are upgrading from SAS Model Manager 12.3 or 13.1 on SAS 9.4 to SAS Model Manager 14.2 on SAS 9.4, additional installation and configurations steps are required. Therefore, two passes of the SAS Deployment Wizard installation and configuration process are required in order to complete the upgrade. During the first pass, the SAS Deployment Wizard detects which products in your existing deployment to upgrade. After the upgrade has completed successfully, the configuration stage begins. After the configuration stage is complete, you must rerun the SAS Deployment Wizard to install the new product components and to complete the configuration.

If you are upgrading from SAS Model Manager 13.1 to 14.2, the upgrade process supports upgrading to a database from the same vendor as the database that you are currently using. Upgrading from a database based on Oracle to a database based on PostgreSQL, or vice versa, is not supported.

If you are using Oracle for your SAS Decision Manager database, the upgrade process assumes that the upgraded environment uses the same instance of Oracle. The upgrade process does not support moving to a different Oracle database server.

Upgrade Steps

To determine the required steps to upgrade to the latest version of SAS Model Manager, see the upgrade instructions in SAS Guide to Software Updates. For instructions about how to complete the installation and configuration process for an upgrade, see “Add SAS Products That Require Configuration” in SAS Intelligence Platform: Installation and Configuration Guide.
Here is product-specific information for running the SAS Deployment Wizard for the second time to complete the upgrade process:

1. Select a plan file that contains SAS Model Manager and SAS Decision Manager Common products. The plan file must be compatible with the plan that was originally used to configure your source system. Verify that you use the new SAS installation data file during this installation.

   Note: For an installation in a multi-machine environment, the server products are typically installed on the SAS Application Server. The rest of the products are on a middle-tier server.

2. In the list of products to be installed, do not change the selections. If there are no product changes, then the deployment wizard does not re-install any pre-existing products.

   Make sure that the following products are among those selected for installation when upgrading from SAS Model Manager 12.3:
   - SAS Decision Manager Common Data Server
   - SAS Decision Manager Common Mid-Tier for Decision Manager
   - SAS Decision Manager Common Mid-Tier for Decision Manager Help and Documentation

3. Some SAS server services must be started before beginning the configuration process.

   Make sure that the following services are started:
   - SAS Decision Manager Common Data Server
     Note: This service is available only when upgrading from SAS Model Manager 13.1.
   - SAS Metadata Server
   - SAS Web Infrastructure Platform Data Server
   - SAS Web Server (httpd - WebServer)
   - SAS Object Spawner
   - SAS JMS Broker
   - SAS Cache Locator

4. Make sure that the following products are among those selected for configuration during the second pass:

<table>
<thead>
<tr>
<th>Product</th>
<th>Upgrading from SAS Model Manager 12.3</th>
<th>Upgrading from SAS Model Manager 13.1</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAS Decision Manager Common Data Server</td>
<td>Yes</td>
<td>Not applicable</td>
</tr>
<tr>
<td>SAS Web Application Server Configuration</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>SAS Lineage Mid-Tier</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>SAS Help Viewer for Mid-Tier Applications</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
When upgrading from SAS Model Manager 12.3 to 14.2, choose Oracle or Decision Manager Common Data Server for the SAS Decision Manager Database type prompt. When you are reconfiguring the SAS Model Manager Mid-Tier, the extracted data from the Model Manager Database is imported automatically into the new Oracle database or SAS Decision Manager Common Data Server PostgreSQL database.

### Post-upgrade Steps

1. After performing an upgrade-in-place for SAS 9.4M6, you must perform additional steps to upgrade from Postgres 9.1 to 9.5. For more information, see Upgrading to Postgres 9.5.

2. After completing the upgrade process with the SAS Deployment Wizard, see the Instructions.html file. The Instructions.html file contains the application URL and instructions that are associated with other products that you have installed. The Instructions.html file is located in `\SAS-configuration-directory\Leven\Documents`.

3. Update your user group memberships, authorization, roles, and capabilities as needed. For more information, see Chapter 6, “Configuring Users, Groups, and Roles,” on page 41.

4. (Optional) Configure your deployment to use HTTPS on page 22.

5. (Optional) Add the Visual Analytics: Data Building and Data Management: Lineage roles to the Decision Manager Users group. These roles enable users to run SAS Visual Data Builder and view lineage information for models. For more information, see “Administering Group and Role Membership” on page 46.

6. (Optional) If you are upgrading from SAS Model Manager 12.3 to 14.2 and are using SAS Workflow, you must perform post-installation configuration and verification steps for SAS Workflow. For more information, see “Configuring SAS Workflow for Use with SAS Model Manager” on page 55.
Chapter 6
Configuring Users, Groups, and Roles

Security Administration Tasks for SAS Model Manager .......................... 41
Administering SAS Identities for Users .................................................. 42
  Overview of SAS Identities ................................................................. 42
  Creating SAS Identities ................................................................. 42
Groups and Group Membership ................................................................. 43
  About Groups ................................................................................ 43
  Predefined User Groups in SAS Model Manager ................................. 43
Roles and Capabilities ............................................................................. 44
  About Roles and Capabilities ............................................................ 44
  Predefined Roles and Capabilities for SAS Model Manager ................. 44
Administering Group and Role Membership .............................................. 46
  Viewing Roles and Capabilities in SAS Management Console .............. 47
  Adding a User to a Group or Role ....................................................... 47
  Creating New Groups and Roles ......................................................... 47
  Modifying Roles ............................................................................ 48
Model Management User Tasks ................................................................. 48
  Overview of Model Management User Tasks ....................................... 48
  Setting Up SAS Model Manager ....................................................... 49
  Setting Up Projects and Portfolios ..................................................... 49
  Importing and Assessing Models ....................................................... 50
  Deploying and Delivering Models ..................................................... 51
  Monitor Champion Model Performance and Retrain Models ................. 51
  General Tasks ............................................................................... 52

Security Administration Tasks for SAS Model Manager

Security administration for SAS Model Manager consists of the following tasks:

• administering SAS identities for your users by adding account information to the SAS Metadata Server
• administering groups of users in order to simplify the management of roles
• administering roles, which provide users with access to specific application features
The information included here is a brief introduction to the concepts of users, SAS identities, groups, roles, and capabilities. For complete information about security administration, see *SAS Management Console: Guide to Users and Permissions* and *SAS Intelligence Platform: Security Administration Guide*.

## Administering SAS Identities for Users

### Overview of SAS Identities

For each SAS Model Manager user, you must create an individual SAS identity on the SAS Metadata Server. The SAS identity is a copy of the ID with which the user logs on to SAS applications. Based on this identity, the system can determine who can access which application and can audit individual actions in the metadata layer. The SAS identity consists of a name, user ID, and password for the user’s external account. This ID can be any type of account that is known to the metadata server’s host, such as an LDAP account, Active Directory account, host account, or other type of account.

When you are entering user IDs for Windows accounts, be sure to qualify the ID (for example, `WIN\myID` or `myID@mycompany.com`).

In a Windows environment, add new users to the Log on as a batch job local security policy on the machine that hosts the SAS Workspace Server.

**Note:** Enter a user ID for Microsoft Windows in the format `domain\userID`. In order for users to be able to schedule jobs with SAS Model Manager, you must specify a valid password for each user’s account in the SAS Metadata Repository. Users must sign in with the same user ID (domain\userID) and password that you specified in their user account.

**Note:** Users who log on to SAS Model Manager using an internal account (a user ID that ends in `@saspw`) cannot access all of the features of the application. All users should be assigned external accounts.

The following users are created as part of the SAS Model Manager installation process:

**Table 6.1  Types of Users**

<table>
<thead>
<tr>
<th>User</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAS Administrator</td>
<td>This user has access to all SAS Management Console capabilities and metadata administrative tasks.</td>
</tr>
<tr>
<td>SAS Demo User</td>
<td>This user is optional. You can choose to create this user during installation. However, this user is not assigned to a group during installation.</td>
</tr>
</tbody>
</table>

### Creating SAS Identities

To create SAS identities for your users, manually enter the information for each user through the User Manager plug-in in SAS Management Console. If you have a large number of users, then you can extract user and group information from one or more
enterprise identity sources. You can then use SAS bulk-load macros to create the identity metadata from the extracted information.

For more information about creating and managing identities, see *SAS Management Console: Guide to Users and Permissions*. For information about the SAS bulk-load macros, see “” in *SAS Intelligence Platform: Security Administration Guide*.

---

**Groups and Group Membership**

**About Groups**

A group is a set of users. Groups enable you to grant multiple users membership in a role or permissions to metadata, thus simplifying security administration. You can create as many groups as are needed in order to manage your installation.

**T I P** A group’s membership can include other groups as well as individual users. This enables you to create a nested group structure.

**Predefined User Groups in SAS Model Manager**

**Table 6.2 Predefined User Groups**

<table>
<thead>
<tr>
<th>Group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Public</td>
<td>This group includes everyone who can access the metadata server, either directly or through a trust relationship. If a user is able to log on to a client application but does not have an individual SAS identity, the user is assumed to be in the public group. Because this group has implicit membership, you cannot explicitly add or remove users from this group.</td>
</tr>
<tr>
<td>SAS Users</td>
<td>This group includes everyone who can access the metadata server, either directly or through a trust relationship. If a user is able to log on to a client application but does not have an individual SAS identity, the user is assumed to be in the public group. Because this group has implicit membership, you cannot explicitly add or remove users from this group.</td>
</tr>
<tr>
<td>SAS Administrators</td>
<td>This is a standard group for metadata administrators. In a standard configuration, members are granted broad access and administrative capabilities, but are not unrestricted.</td>
</tr>
<tr>
<td>Decision Manager Common</td>
<td>This group has administrative permissions. Membership in this group is required to administer workflows. In your initial installation, this group is a member of the following roles:</td>
</tr>
<tr>
<td>Administrators</td>
<td>• Decision Manager Common: Administration</td>
</tr>
<tr>
<td></td>
<td>• Model Manager: Administration Usage</td>
</tr>
<tr>
<td>Group</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Decision Manager Users</td>
<td>This group is created during the installation process. Members of this group have permission to read, add, or delete table summary information in the Data category.</td>
</tr>
<tr>
<td>Model Manager Administrator Users</td>
<td>This group has administrative permissions in the Projects and Portfolio categories. For specific user tasks that can be performed, see “Model Management User Tasks” on page 48.</td>
</tr>
<tr>
<td>Model Manager Advanced Users</td>
<td>This group has permissions to read, write, and delete content in the Projects and Portfolios categories. For specific user tasks that can be performed, see “Model Management User Tasks” on page 48.</td>
</tr>
<tr>
<td>Model Manager Users</td>
<td>This group has permission to read content in the Projects category. For specific user tasks that can be performed, see “Model Management User Tasks” on page 48.</td>
</tr>
<tr>
<td>SAS System Services</td>
<td>This group enables members to export files on the Folders tab of SAS Management Console.</td>
</tr>
</tbody>
</table>

**Roles and Capabilities**

**About Roles and Capabilities**

A role manages the availability of application features such as menu items and plug-ins. An application feature that is under role-based management is called a capability.

Certain actions are available only to users or groups that have a particular capability. Any user or group who is a member of a role has all of that role’s capabilities.

Roles can contribute to one another. A role automatically includes all of the capabilities of a role that contributes to it.

Roles differ from permissions. In general, roles do not affect access to metadata or data.

**Predefined Roles and Capabilities for SAS Model Manager**

Your installation includes several predefined roles for administrators and users of SAS Model Manager. Depending on what software you have installed, you might have other predefined roles.

*Note:* The ability to access and update metadata is subject to permissions that are placed on that metadata. These roles do not affect permissions.
<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
</table>
| Decision Manager Common: Administration | Enables users to perform all Decision Manager Common tasks, including administering workflows.  
   This role is assigned to the group Decision Manager Common Administrators and has the Decision Manager Common: Workflow category capability.  
   | Model Manager: Administration Usage | Enables users to perform all model management tasks. For specific user tasks that can be performed, see “Model Management User Tasks” on page 48.  
   This role is assigned to the group Model Manager Administrator Users and has the following Model Manager Plug-in capabilities by default:  
   - Model Projects category  
   - Model Portfolios category  
   | Model Manager: Advanced Usage | Enables users to perform all model management tasks except for tasks that can be performed only by an application administrator. For specific user tasks that can be performed, see “Model Management User Tasks” on page 48.  
   This role is assigned to the group Model Manager Advanced Users and has the following Model Manager Plug-in capabilities by default:  
   - Model Projects category  
   - Model Portfolios category  
   | Model Manager: Usage | Enables users to perform general model management tasks, such as viewing project and model information. For specific user tasks that can be performed, see “Model Management User Tasks” on page 48.  
   This role is assigned to the group Model Manager Users and has the following Model Manager Plug-in capabilities by default:  
   - Model Projects category  
   | Comments: Administrator | Enables users to edit or delete comments.  
   The ability to edit and delete comments is controlled by the capabilities under Applications ⇒ SAS Application Infrastructure ⇒ Comments in SAS Management Console.  
<p>|</p>
<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Management: Lineage</td>
<td>Provides default access to the SAS Lineage application. This role is predefined, but it is not automatically added to the Decision Manager Users group. To enable SAS Model Manager users to access SAS Lineage, add the Data Management: Lineage role to the Decision Manager Users group. See “Adjust Group or Role Membership” in SAS Management Console: Guide to Users and Permissions for instructions.</td>
</tr>
<tr>
<td>Management Console: Advanced</td>
<td>Provides access to all plug-ins in SAS Management Console. This role is assigned to the group SAS Administrators.</td>
</tr>
<tr>
<td>Metadata Server: Operation</td>
<td>Supports adding metadata repositories and operating the metadata server. This role is assigned to the group SAS Administrators.</td>
</tr>
<tr>
<td>Metadata Server: User Administration</td>
<td>Supports management of users, groups, and roles other than the unrestricted users role. This role is assigned to the group SAS Administrators.</td>
</tr>
<tr>
<td>Metadata Server: Unrestricted</td>
<td>Provides all capabilities in SAS Management Console and provides access to all metadata. This role is assigned to the group SAS Administrator Users.</td>
</tr>
<tr>
<td>Visual Analytics: Data Building</td>
<td>Enables users to access SAS Visual Data Builder. This role is predefined, but it is not automatically added to the Decision Manager Users group. To enable SAS Model Manager users to access SAS Visual Data Builder, add the Visual Analytics: Data Building role to the Decision Manager Users group. See “Adjust Group or Role Membership” in SAS Management Console: Guide to Users and Permissions for instructions.</td>
</tr>
</tbody>
</table>

**Administering Group and Role Membership**

To administer group and role membership, use the User Manager plug-in in SAS Management Console.
Viewing Roles and Capabilities in SAS Management Console

To view details about a role, open the User Manager plug-in in SAS Management Console, right-click the role, and select **Properties**. You can then view tabs that display the role’s members, capabilities, and contributing roles.

*Note:* The preferred way to manage permissions for viewing vocabularies and lookup tables is by using capabilities under **Vocabulary/Entity/Term** and **Lookup**. The **Manage Vocabulary/Lookup definitions** capability is for compatibility with previous releases.

*Note:* Some roles have implicit capabilities that are not specified on the **Capabilities** tab.

The following table describes the icons used in the Properties window.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="icon1.png" alt="Icon" /></td>
<td>None of the capabilities in this category have been specified for this role.</td>
</tr>
<tr>
<td><img src="icon2.png" alt="Icon" /></td>
<td>Some of the capabilities in this category have been specified for this role, either explicitly or through a contributing role.</td>
</tr>
<tr>
<td><img src="icon3.png" alt="Icon" /></td>
<td>All of the capabilities in this category have been specified for this role, either explicitly or through a contributing role.</td>
</tr>
</tbody>
</table>

Shaded check boxes indicate capabilities that come from contributing roles.

Adding a User to a Group or Role

In most cases, the best way to place a user in a role is to add the user to a group that belongs to the role. You can also add users directly to groups or roles.

To place a user in one of the predefined roles, you can add the user to one of the predefined groups. For example, to add a user to the Decision Manager Common: Administration role, add the user to the Decision Manager Common Administrators group.

For more information, see *SAS Management Console: Guide to Users and Permissions*.

Creating New Groups and Roles

The predefined groups and roles might be sufficient for many sites. Other sites might need to make application features available to users on either a broader or more granular basis than the predefined groups or roles allow.

You can use combinations of capabilities to create a new role. However, you can use only the capabilities that already appear in User Manager. You cannot create new capabilities.

For detailed information about roles and how to create them, see *SAS Management Console: Guide to Users and Permissions*. 
Modifying Roles

The User Manager plug-in in SAS Management Console enables you to modify roles by selecting or deselecting different capabilities.

**CAUTION:**

*No automated method can revert a role to its original set of capabilities.* Instead of adjusting the capabilities of a predefined role, consider creating a new role. This advice is especially important if you need to make major changes.

If you modify a role, then follow these best practices:

- Do not rename the predefined roles. Renaming the predefined roles makes it difficult for SAS Technical Support to help you resolve problems.
- Keep a record of the changes that you make.

When modifying a role, you can use only the capabilities that already appear in User Manager. You cannot create new capabilities.

For more information about roles and how to modify them, see *SAS Management Console: Guide to Users and Permissions*.

---

Model Management User Tasks

**Overview of Model Management User Tasks**

When you work in SAS Model Manager, the application administrator assigns your user ID to one of three SAS Model Manager groups: Model Manager Administrators, Model Manager Advanced Users, and Model Manager Users. Groups can perform certain tasks within SAS Model Manager. For example, users in the Model Manager Administrator group are the only users who can lock a version.

Users in the Model Manager Administrator Users group can perform all task in the Models category view. The Model Manager Advanced Users and Model Manager Users groups are more restrictive. See the tables in the subsequent sections for a list of tasks and the groups whose users can perform the task.

An application administrator can create custom groups for your organization as well as assign roles to those groups. The pre–defined roles enable specific users or groups to be assigned in order to complete specific tasks within SAS Model Manager. In most cases, roles are assigned to groups. Three of the roles are general and correspond to the groups that are supplied by SAS Model Manager. Contact your application administrator to find out your group and roles.

The following table lists the abbreviations for groups that are used in the task tables below:

<table>
<thead>
<tr>
<th>Group</th>
<th>Abbreviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model Manager Administrator Users</td>
<td>MM Admin</td>
</tr>
<tr>
<td>Model Manager Advanced Users</td>
<td>MM Adv User</td>
</tr>
</tbody>
</table>
### Setting Up SAS Model Manager

Use the following table to determine the users who can complete the tasks to set up SAS Model Manager:

<table>
<thead>
<tr>
<th>Task</th>
<th>Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create users in SAS Management Console</td>
<td>SAS Administrator</td>
</tr>
<tr>
<td>Create data libraries in SAS Management Console</td>
<td>DCM Admin, DCM User, MM Adv User, MM Admin, SAS Administrator</td>
</tr>
<tr>
<td>Create data libraries in the Data category view</td>
<td>DCM Admin, DCM User, MM Adv User, MM Admin, SAS Administrator</td>
</tr>
<tr>
<td>Create channel location folders on a SAS server</td>
<td>MM Admin</td>
</tr>
<tr>
<td>Create SAS channels in SAS Management Console</td>
<td>SAS Administrator</td>
</tr>
<tr>
<td>Define channel subscribers in SAS Management Console</td>
<td>SAS Administrator</td>
</tr>
<tr>
<td>Create project tables</td>
<td>MM User, MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Register tables</td>
<td>DCM Admin, DCM User, MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Configure the SAS Content Server for SAS Model Manager</td>
<td>SAS Administrator</td>
</tr>
<tr>
<td>Create workflows</td>
<td>MM Admin, MM Adv User, MM User, DCM Admin</td>
</tr>
<tr>
<td>Manage workflows</td>
<td>DCM Admin</td>
</tr>
</tbody>
</table>

### Setting Up Projects and Portfolios

Use the following table to determine the users who can complete the tasks to set up projects and versions in SAS Model Manager:

<table>
<thead>
<tr>
<th>Task</th>
<th>Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create users in SAS Management Console</td>
<td>SAS Administrator</td>
</tr>
<tr>
<td>Create data libraries in SAS Management Console</td>
<td>DCM Admin, DCM User, MM Adv User, MM Admin, SAS Administrator</td>
</tr>
<tr>
<td>Create data libraries in the Data category view</td>
<td>DCM Admin, DCM User, MM Adv User, MM Admin, SAS Administrator</td>
</tr>
<tr>
<td>Create channel location folders on a SAS server</td>
<td>MM Admin</td>
</tr>
<tr>
<td>Create SAS channels in SAS Management Console</td>
<td>SAS Administrator</td>
</tr>
<tr>
<td>Define channel subscribers in SAS Management Console</td>
<td>SAS Administrator</td>
</tr>
<tr>
<td>Create project tables</td>
<td>MM User, MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Register tables</td>
<td>DCM Admin, DCM User, MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Configure the SAS Content Server for SAS Model Manager</td>
<td>SAS Administrator</td>
</tr>
<tr>
<td>Create workflows</td>
<td>MM Admin, MM Adv User, MM User, DCM Admin</td>
</tr>
<tr>
<td>Manage workflows</td>
<td>DCM Admin</td>
</tr>
</tbody>
</table>
### Task and Group Permissions

<table>
<thead>
<tr>
<th>Task</th>
<th>Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create folders</td>
<td>MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Create portfolios</td>
<td>MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Create projects</td>
<td>MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Create versions</td>
<td>MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Delete folders, projects, and portfolios</td>
<td>MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Archive and restore folders</td>
<td>MM Adv User, MM Admin, MM Admin</td>
</tr>
<tr>
<td>Create and manage model and report templates</td>
<td>MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Create a workflow</td>
<td>MM User, MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Assign participants to a workflow</td>
<td>DCM Admin</td>
</tr>
<tr>
<td>View workflows that are associated with a version</td>
<td>DCM Admin</td>
</tr>
</tbody>
</table>

**Importing and Assessing Models**

Use the following table to determine the users who can complete the tasks to import and assess models:

<table>
<thead>
<tr>
<th>Task</th>
<th>Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import models</td>
<td>MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Configure model properties</td>
<td>MM Adv User, MM Admin</td>
</tr>
<tr>
<td>View lineage and relationships for a model</td>
<td>MM User, MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Map model variables to project variables</td>
<td>MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Run model comparison and model validation reports</td>
<td>MM Adv User, MM Admin</td>
</tr>
</tbody>
</table>

**Note:**
- An MM Adv User must have Write permissions to save a new template or changes to an existing template. For more information, see “Verify WebDAV Folder Permissions for User-Defined Templates” on page 17.
- To view the relationships for a model in the SAS Lineage application, the Data Management: Lineage role must be associated with a user or group the user is in.
### Model Management User Tasks

<table>
<thead>
<tr>
<th>Task</th>
<th>Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create user reports</td>
<td>MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Create aggregated reports</td>
<td>MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Create scoring output tables</td>
<td>MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Create and run scoring tests</td>
<td>MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Schedule a scoring test to execute</td>
<td>MM Adv User, MM Admin</td>
</tr>
</tbody>
</table>

### Deploying and Delivering Models

Use the following table to determine the users who can complete the tasks to deploy and deliver models:

<table>
<thead>
<tr>
<th>Task</th>
<th>Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set a champion model</td>
<td>MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Flag a challenger model</td>
<td>MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Validate the champion model by running a scoring test using test data and reviewing the scoring output</td>
<td>MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Lock or unlock versions</td>
<td>MM Admin</td>
</tr>
<tr>
<td>Publish a project or model to a SAS channel</td>
<td>MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Extract a champion model from a SAS channel</td>
<td>any user who has the appropriate access rights to the SAS Metadata Repository</td>
</tr>
<tr>
<td>Publish a model to the SAS Metadata Repository</td>
<td>MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Publish a model scoring function or model scoring files to a database</td>
<td>MM Adv User, MM Admin</td>
</tr>
</tbody>
</table>

### Monitor Champion Model Performance and Retrain Models

Use the following table to determine the users who can complete the tasks to create and run the reports that are used to monitor the champion model performance and to retrain models:
### Task Group

<table>
<thead>
<tr>
<th>Task</th>
<th>Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set project properties</td>
<td>MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Monitor performance of project champion models that are within a portfolio</td>
<td>MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Edit a performance definition</td>
<td>MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Schedule a performance definition to execute</td>
<td>MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Execute the performance definition.</td>
<td>MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Run performance monitoring batch jobs in <strong>Test</strong> mode: MM User, MM Adv User, MM Admin</td>
<td></td>
</tr>
<tr>
<td>Run performance monitoring batch jobs in <strong>Production</strong> mode: MM Adv, MM Admin</td>
<td></td>
</tr>
<tr>
<td>View monitoring reports and charts</td>
<td>MM User, MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Delete performance data sets</td>
<td>MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Create and manage dashboard report definitions</td>
<td>MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Generate dashboard reports</td>
<td>MM Adv User, MM Admin</td>
</tr>
<tr>
<td>View dashboard reports</td>
<td>MM User, MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Edit a model retrain definition</td>
<td>MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Execute or schedule a model retrain definition</td>
<td>MM Adv User, MM Admin</td>
</tr>
<tr>
<td>View retrained models and the associated model comparison reports</td>
<td>MM User, MM Adv User, MM Admin</td>
</tr>
</tbody>
</table>

### General Tasks

Use the following table to determine the users who can complete these general tasks:

<table>
<thead>
<tr>
<th>Task</th>
<th>Group or Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add attachments and comments</td>
<td>MM User, MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Search for models</td>
<td>MM User, MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Set the status of a project champion model and challenger models</td>
<td>MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Replace a champion model</td>
<td>MM Adv User, MM Admin</td>
</tr>
<tr>
<td>Task</td>
<td>Group or Role</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>View workflow tasks</td>
<td>MM User, MM Adv User, MM Admin</td>
</tr>
<tr>
<td></td>
<td>A user must be the actual owner of a task or assigned the workflow participant role of potential owner or business administrator to view tasks in the My Tasks category</td>
</tr>
<tr>
<td>Work with workflow tasks</td>
<td>MM User, MM Adv User, MM Admin</td>
</tr>
<tr>
<td></td>
<td>A user who is a workflow participant can claim, release, and complete tasks.</td>
</tr>
</tbody>
</table>
Chapter 7
Configuring SAS Workflow

Configuring SAS Workflow for Use with SAS Model Manager

Overview
SAS Workflow provides services that work together to model, automate, integrate, and streamline business processes. It provides a platform for more efficient and productive business solutions.

SAS Workflow is used by SAS solutions that benefit from business process management. SAS Workflow Studio is a desktop client application that is used to design and deploy workflow definitions. The SAS middle tier hosts the workflow engine and the workflow services as part of the SAS Web Infrastructure Platform. SAS Model Manager is used to manage the workflows that are associated with versions. For more information about SAS Workflow, see “SAS Workflow” in SAS Intelligence Platform: Middle-Tier Administration Guide.

Prerequisites for Using SAS Workflow
To use SAS Workflow with SAS Model Manager, be sure the following prerequisites are met:

1. SAS Workflow Engine, SAS Workflow Services, and SAS Workflow Studio must be installed and configured. For more information, see SAS Intelligence Platform: Installation and Configuration Guide.
2. If you want to receive notifications for a workflow, you must configure alert notifications using SAS Management Console. For more information, see “Configure Alert Notifications for SAS Workflow” on page 59.

3. The **Workflows category** capability (under **Decision Manager 3.2 ⇒ Decision Manager Common**) must be selected for the Decision Manager Common: Administration role. See “Administering Group and Role Membership” on page 46 for more information.

4. Users must be a member of the Decision Manager Common Administrators Group or of another user group that is associated with the Decision Manager Common: Administration role.

5. In SAS Web Administration Console, the users or groups must be assigned to a workflow template management role. For more information, see Deploying and Maintaining Workflows in *SAS Workflow Studio: User’s Guide*.

6. Workflow definitions must be created using SAS Workflow Studio. For more information about creating workflow definitions, see Defining Workflows with SAS Workflow Studio in *SAS Workflow Studio: User’s Guide*.

### Guidelines for Creating Workflow Definitions

When you create workflow definitions in SAS Workflow Studio to use with SAS Model Manager, follow these guidelines:

- Participants, and policies must be added to the task level. Statuses added at the task level and the default statuses at the workflow definition level can be used for a task status. Data objects can be added at the workflow definition level or task level. Users can see only the data objects defined at the task level from the Workflows category in SAS Model Manager.

- Only the Potential Owner and Business Administrator workflow roles are used by SAS Model Manager and they can be used in either a participant or swimlane definition. The Actual Owner workflow role should not be used as part of a workflow definition.

- In order to assign additional participants to tasks in SAS Model Manager, the user must have or be in a group that is assigned the workflow role of Business Administrator. Also, in order to manage workflows and assign participants, the user must be in the Decision Manager Common Administrators group, or in a group that is a member of the Decision Manager Common Administrators group or that is associated with the Decision Manager Common: Administration role in SAS Management Console.

The following groups are created at installation time:

- Decision Manager Common Administrators Group
- Decision Manager Users Group
- Model Manager Administrator Users Group (mdlmgradminusers)
- Model Manager Advanced Users Group (mdlmgradvusers)
- Model Manager Users Group (mdlmgrusers)

For more information, see Chapter 6, “Configuring Users, Groups, and Roles,” on page 41.
Only workflow definitions that are activated in the Workflow repository, that are associated with the `mmapi` tag attribute in the file properties, are available to SAS Model Manager.

**Add the Approval Attribute to a Status**

The **Approval** attribute allows a workflow designer to signify that a specific task approves the associated version for a model project. This attribute then notifies the users of the version that a project is approved.

To add the **Approval** attribute to a status:

1. Expand the **Statuses** folder in the **Workflow Tree**.
2. Right-click a status and select **Edit**.
3. Click **Attributes**.
4. Click **Add** and enter the following values for the new attribute.
   - **Key**: Approval
     - **Note**: This key is case-sensitive.
   - **Value**: true
5. Click **OK** twice to save.

**Make Workflow Definitions Available to SAS Model Manager**

After you have created a workflow definition in the SAS Workflow Studio, you must make the workflow definition available to SAS Model Manager.

To save the workflow definition to the Workflow repository:

1. Save the workflow definition to your local drive.
2. Log on to the server.
3. Add the tag attribute of `mmapi` to the workflow definition file properties.
4. Upload the workflow definition.
5. **Verify that the workflow definition** is available in the Workflows category.

For more information, see *Deploying and Maintaining Workflows* in *SAS Workflow Studio: User’s Guide*.

**Log On to the Server**

With SAS Workflow Studio, you are limited to managing locally stored workflow definitions on your system until you have logged on to the SAS Content Server. After you are connected, you can access additional workflow definitions that are stored in the SAS Content Server.

To log on to the server:
1. Select **Server ➔ Log On**.
2. In the Log On window, select the host-name from the **SAS environment** drop-down list.
   
   *Note:* For more information, see “Configuring the SAS Environment File” in *SAS Intelligence Platform: Middle-Tier Administration Guide*.
3. Enter a user ID and password, and click **Log On**.
4. Click **OK** if a confirmation message appears.

**Add Tag Attributes to a Workflow Definition**

Only those workflow definitions in the Workflow repository that contain the `mmapi` tag attribute in the file properties are available to SAS Model Manager.

To add a tag attribute to the file properties of a workflow template in SAS Workflow Studio:
1. Select **File ➔ Properties** and click **Add**.
2. Enter the tag value of `mmapi`.
   
   *Note:* The file properties are case sensitive. This value must be lowercase.
3. Click **OK** twice.

**Upload a Workflow Definition**

To upload a workflow:
1. From the **Server** menu, select the **Save to Repository** menu option. The Save to Workflow Repository window appears.
2. (Optional) Enter relevant comments to associate with the workflow definition.
3. Select the **Activate** option if you want to activate the current version in the Workflow repository.
4. Click **OK**.
5. Click **OK** if confirmation messages appear.
**Verify That the Workflow Definitions Are Available In SAS Model Manager**

To verify that the workflow definitions are available in the Workflows category view of SAS Model Manager:

1. Enter the URL `http://hostname:port/SASDecisionManager` in your web browser.
2. Enter the user ID and password for a user that is in the Decision Manager Common Administrators Group or a user group that is associated with the Decision Manager Common: Administration role.
3. Verify that the uploaded workflow definition is available in the Workflows category view. From the Workflows category view, select **Actions** ⇒ **Set Mappings**. The Set Mappings window appears with a list of the available workflow definitions.

For more information, see “Set Mappings” in *SAS Model Manager: User’s Guide*.

**Migrate Workflows**

If you have migrated from SAS Model Manager 12.1 or 12.3, you must migrate the workflows. All active (in progress) or completed workflows will be migrated. Terminated workflows are not migrated. The workflows must also be associated with a valid UUID for a version of a project. Only workflows that are associated with a project that still exists are migrated. If the project was deleted, the associated workflow is not migrated.

Select **Workflows** ⇒ **Actions** ⇒ **Migrate from Previous Version**. The list of workflows is refreshed after the workflows are migrated.

**Configure Alert Notifications for SAS Workflow**

To enable workflow participants to receive alert notifications from SAS Workflow, you must configure the E-mail notification type in SAS Management Console. After you have configured the alert notifications, you can then use the Notify Participant policy and other workflow notification policies for workflow tasks in SAS Workflow Studio. The notifications setting in SAS Management Console is a global setting. Preferences and notifications can also be configured for individual users.

The Send Notification By Data Object policy in SAS Workflow Studio integrates with the SAS Web Infrastructure Platform's Notification Service. Recipients are notified according to their preferences (e-mail or portlets).

1. Log on to SAS Management Console as an administrator.
2. On the **Plug-ins** tab, navigate to **Application Management** ⇒ **Configuration Manager** ⇒ **SAS Application Infrastructure**.
3. Right-click **SAS Application Infrastructure** and select **Properties**.
4. Click the **Settings** tab.
5. Select **Notifications** in the left panel. Use the menus or text fields to set the property.
6. Select the **E-mail** notification type.
7. Click **OK**.
8. To apply this setting and make it available, restart the SAS Web Infrastructure Platform Services, SAS Shared Services, and applications using SAS Workflow.

For more information about the notification properties, see “Setting Global Properties for SAS Applications” in SAS Intelligence Platform: Middle-Tier Administration Guide. For more information about setting the notification policies for SAS Workflow, see the SAS Workflow Studio Help or SAS Workflow Studio: User’s Guide.
Overview of Creating and Configuring Publication Channels

SAS Model Manager uses the SAS Publishing Framework to publish model updates to an operational environment for testing and production. The SAS Administrator creates and configures definitions for channels, content subscribers, and group subscribers. Then the user can use the SAS Model Manager model extraction macros or user-written SAS code to retrieve and deploy the updated models to the operational environment.

As shown in the following figure, several tasks are necessary to configure and use the SAS Model Manager publishing functionality.
Here are the tasks.

1. The application administrator creates either an archive or a WebDAV persistent storage location for channels that is accessible from the SAS Workspace Server.

2. The application administrator creates users, HTTP servers, content subscribers, and channels using SAS Management Console.

3. The application administrator or an advanced user publishes models using SAS Model Manager.

4. The content subscriber (for example, Scoring personnel) receives an email notification from the server that contains a channel content update.

5. The content subscriber extracts models from a channel (for example, on a SAS Content Server) to prepare them for scoring.

*Note:* SAS Management Console Help provides details for your SAS Model Manager publishing configuration options.

It is recommended that at first you use channels that have the Archive File type for the persistent storage option. This is the simplest channel definition and configuration to use to publish directly to your operational testing or production scoring servers. For example, during the installation of SAS Model Manager, a channel that has a persistent...
store Archive File type is created. The channel is called **MMChannel**. For more information, see “Create a New Channel” on page 68.

**Note:** When the SAS Web Application Server and the SAS Workspace Server are located on different physical machines, the Software Deployment Wizard creates a directory on the SAS Web Application Server machine and uses that value for the **App.ChannelDir** property value. You must create a directory that is accessible by the SAS Workspace Server, and the SAS Model Manager users must have permissions to that directory. For more information, see “Modify an Existing Channel or Channels Node Location” on page 70.

---

### Define an HTTP or HTTPS Server

The SAS Model Manager installation process by default defines a SAS Web Server and a SAS Content Server. Use this process to add additional HTTP or HTTPS servers. A WebDAV-enabled HTTP or HTTPS content server must be defined in SAS Management Console before you can publish to channels from SAS Model Manager. The server is usually a third-party server such as Microsoft Internet Information server or an Apache server.

**Note:** You must have WriteMetadata permission for a repository in order to define an HTTP or HTTPS content server for that repository.

To define your HTTP or HTTPS content server:

1. Start SAS Management Console. Open your existing connection profile for your server. If your connection profile is not available in the list, see SAS Management Console Help.

2. From the **Plug-ins** tab, right-click **Server Manager**, and then select **New Server**.

3. Select **Resource Templates** ➔ **Servers** ➔ **Content Servers** ➔ **Http Server**, and then click **Next**.

   **Note:** If the HTTP server template is not available, then you must add the resource template. For more information, see the SAS Management Console Help.

4. Enter the name and the description of your HTTP server. Click **Next**.

5. (Optional) On the server properties page, enter the software version and vendor information for the third-party HTTP or HTTPS server that you are defining.

6. Click **New** to create a base path or paths on your server.

   **Note:** If you have not defined the base path for your HTTP server, see “ Define Publish Locations for the SAS Content Server” on page 64.

7. In the **Base Path** field, specify the location of the top-level directory where report content items such as report definitions or image files are stored. (This path must be set up as an alias on the web server.) The **Description** field is optional.

8. Select the **Supports WebDAV** option and then click **OK** to save your settings. The new base path appears in the **Base Path(s)** field of the server properties page.

9. Click **Next**.

10. Enter the connection properties for your HTTP server:

    a. Select **DefaultAuth** from the list. When you click **New** to create a new domain, a dialog box appears. Enter the name and description of your domain.
b. Enter the fully qualified name or the IP address of your server.

c. Enter a port number (for example, 8080 for a web application server).

11. Click **Next**. The New Server Wizard window displays a summary of the settings for the new server and indicates that you have successfully completed the definition of a new server.

12. Click **Finish**. Your new server is displayed under the Server Manager node in the SAS Management Console Navigation Tree.

**See Also**

- SAS Management Console Help
- *SAS Intelligence Platform: Middle-Tier Administration Guide*

---

**Define Publish Locations for the SAS Content Server**

During the SAS Model Manager installation process, the **ModelManager**, **sasfolders**, and **sasdav** WebDAV folders are automatically created on the SAS Content Server. You can use the SAS Content Server Administration Console (SCS Admin Console) to create a new publishing location for the WebDAV folder or to control access to an existing WebDAV folder. If you need to define a new WebDAV-enabled HTTP content server after the initial installation of SAS Model Manager, then you must define a publishing location. For more information, see “Define an HTTP or HTTPS Server” on page 63.

**Note:** Although you can add a folder to the **sasfolders** location, the folder that you add is not added to the SAS Metadata Server.

**TIP** The best practice is to add folders to metadata using SAS Management Console.

To define a new publishing location:

1. Access the SAS Content Server Administration console by entering the following URL in your web browser and substituting the server name and port number of your SAS Content Server: `http://server-name:port/SASContentServer/ dircontents.jsp`.

   **Note:** The default port number for the SAS Web Application Server is 80 for a UNIX environment and 7980 for a Windows environment.

2. Sign in to the console as an unrestricted user (for example, SAS Administrator). The SCS Admin Console window appears.
3. Enter a name for the folder in the text box and then click Add folder to create a new location for publishing channels.

4. (Optional) To create a subfolder, select the folder that you created in the previous step, enter a name for the subfolder in the text box, and click Add folder.

   **Note:** Use the breadcrumb trail above the list to return to a parent folder.

5. To set permissions for a folder:

   a. Click the permission icon next to the item that you want to modify. The Permissions page appears.

   b. For each principal that is listed, modify the permissions by changing each permission to Yes or No.

   c. To add more principals to the page, do one of the following:
      
      • If you know the principal's name, enter it in the field and click Save changes.
      
      • Click Search for Principals to search for a name. When you find the principal that you want to add, select the check box that is next to the principal's name and then click Return.

      After the principal's name appears on the permission page, you can set permissions for the principal.

   **Note:** For more information about administering the SAS Content Server, see *SAS Intelligence Platform: Web Application Administration Guide*.

---

**Configuring Channels and Subscribers for SAS Model Manager**

**Overview of Configuring Channels and Subscribers**

The Publishing Framework plug-in to SAS Management Console enables you to administer the Publishing Framework.

**Note:** You need to verify that Publishing Framework plug-ins are available in your SAS Management Console navigation tree. If the plug-in is not available, you need to install SAS Foundation Services 1.3 or later so that you can configure your channels and subscribers for SAS Model Manager.

With the Publishing Framework plug-in, you can manage subscribers and channels. For more information, see the Help.
When the Publishing Framework plug-in is available, the SAS Management Console Project Tree should look as follows:

![SAS Management Console Project Tree](image)

The SAS Metadata Server (for example, Foundation) that is shown under the Publishing Framework plug-in contains the Subscribers folder and the Channels folder.

The Publishing Framework plug-in to SAS Management Console provides wizards that enable you to create subscribers. When you create a subscriber with a wizard, the subscriber object that has the specified attributes is stored on the SAS Metadata Server.


**Channel to Subscriber Configuration**

There are several ways to configure channels to publish your models to the channel subscribers.

Choose one of these options to define the method to use for publishing channels:

1. **None** - specifies to publish all content that is published to the channel directly to the subscribers (through e-mail). The content is not persisted.

2. **Archive** - specifies a path and an optional logical server for the location of the persistent storage. The *Archive File* option is recommended for publishing model packages. Publishing Framework publishes the content as an archive (binary) SPK (SAS package) file to the persistent storage location.

3. **WebDAV** - specifies the WebDAV server location.

**TIP** The best practice is to use the *Archive File* type for channel persistent storage and *e-mail* for subscriber notification.

Before publishing models using SAS Model Manager, you must create channels and subscribers to publish your model updates.
Creating Channels and Subscribers

The channel sends the information from the publishers to the subscribers who want it. A subscriber is a person or a program that has a need for information that is published. To receive information from a channel, the user must be defined as a subscriber. The Publishing Framework plug-in provides wizards that enable you to create subscribers. Information about the subscriber is stored on the SAS Metadata Server.

Note: Channel subscribers must be users of the SAS Metadata Server and their e-mail addresses must be specified.

Create a Channel Folder

If you expect to create a large number of channels, then consider grouping related channels into channel folders. You can create subfolders within folders, thereby creating a folder hierarchy to which access controls can be applied. For more information, see the SAS Management Console Help.

Note: Currently it is not possible to move an existing channel into a folder or from one folder to another. Plan ahead to avoid deleting and re-creating channels.

To create channel folders:

1. From the SAS Management Console navigation tree, expand the Publishing Framework node.

2. Select and expand the desired metadata repository node.

3. If you are creating a top-level folder, then select Channels. If you are creating a subfolder, then navigate to and select the desired parent folder.
4. Right-click **Channels** and then select **New Folder**.

5. Enter a name for the new channel folder and then click **Next**. The new folder is created and the metadata definition information is displayed.

6. Click **Finish**.

---

**Create a New Channel**

To create a new channel:

1. From the SAS Management Console navigation tree, expand the **Publishing Framework** node.

2. Select and expand the desired metadata repository node.

3. If you are creating a channel within a folder, select the **Channels** node and navigate to the desired folder.

4. Right-click **Channels** or the desired channel folder and select **New Channel**.

5. Specify the name of your channel and click **Next**.

6. Use the arrow button to associate content subscribers with this channel to be notified at publish time. Click **Next**.

7. Select **Archive**.

8. Select **File** for **Archive Type** and enter the path of your publish location. Click **Next**.

   The information window appears, providing a summary of the input and status of successful completion of the channel creation.

   **Note:** Two other types, HTTP and FTP, are available for you to select from the list.

9. Click **Finish**. The new channel name is displayed under the **Channels** node of SAS Management Console.

For more information, see the SAS Management Console Help or *SAS 9.4 Publishing Framework: Developer's Guide*.

---

**Create a New Subscriber**

SAS Model Manager supports only the content subscriber and the Name/Value pair filter for filtering. You can publish to a channel even when the channel does not have any associated subscribers. SAS Model Manager users can extract contents from a channel if they are not subscribers of the channel. However, only subscribers of a channel can receive notifications. You can also create a subscriber group that contains individual subscribers or other subscriber groups. For more information, see the SAS Management Console Help.

To create a new content subscriber:

1. Expand the **Publishing Framework** node in the SAS Management Console navigation tree.

2. Select the desired metadata repository node.
3. Select **Subscribers ➔ Content Subscribers**.

4. Right-click **Content Subscribers** and select **New Content Subscriber**.

5. Specify a name and a description for this subscriber. The name must be unique within its parent folder. The description is optional. Click **Next**.

6. Click **Select** to associate a person with this subscriber.

7. The search filter enables you to search the repository for users whose names either contain or are equal to a string that you specify. Enter the string in the text field, select either **contains** or **equals** from the list, and click **Search**. A list of users whose names meet your search criteria appears in the **Available People** list.

8. If the desired user does not exist in the repository, then click **New User** to define that user. Then, select the desired user from the **Available People** list and click **OK**.

9. Click **Next**.

10. Select the subscriber's delivery transport and then specify the attributes. Click **Next**.

11. Specify one or more filters to eliminate content that the subscriber does not want to receive. To add a filter, click the tab that corresponds to the type of filter (Name/Value, Entry, or MIME Type). Select **Inclusion** or **Exclusion** and then click **Add** to specify the filter criteria.

12. Click **Next**.

13. Review the subscriber specifications. Click **Back** to make any corrections. Click **Finish** when you are satisfied with your selections.

For more information, see the Help or **SAS 9.4 Publishing Framework: Developer's Guide**.
Modify an Existing Channel or Channels Node Location

Modify the Directory Location for the Channels Node

To change the location of the application channels directory:

1. From SAS Management Console, expand the Application Management node on the Plug-ins tab.
2. Select and expand Configuration Manager ⇄ SAS Application Infrastructure ⇄ Enterprise Decision Manager 3.2.
4. Click the Advanced tab to modify the application channels directory. Change the property value for App.ChannelDir to a directory that is accessible by the SAS Workspace Server.
5. Click OK.

Modify the Persistent Store Directory Location for a Channel

To modify the location of the persistent store directory path for a channel:

1. From the SAS Management Console navigation tree, expand the Publishing Framework node.
2. Select and expand the desired metadata repository node.
3. If you are modifying a channel within a folder, select the Channels node and navigate to the desired folder.
4. Right-click the name of the channel that you want to modify, and then select Properties.
5. Click the Persistent Store tab, and modify the archive file path and server location.
6. Click OK.

See Also

SAS Management Console Help
Here is the recommended reading list for this title:

- The online Help for the SAS Model Manager
- *SAS Workflow Studio 1.3: User's Guide*
- *SAS In-Database Products: Administrator's Guide*
- *SAS Intelligence Platform: Installation and Configuration Guide*
- *SAS Intelligence Platform: Middle-Tier Administration Guide*
- *SAS Intelligence Platform: Desktop Application Administration Guide*
- *SAS Intelligence Platform: System Administration Guide*
- *SAS Intelligence Platform: Web Application Administration Guide*
- *SAS Factory Miner: Administration and Configuration*

For a complete list of SAS publications, go to [sas.com/store/books](http://sas.com/store/books). If you have questions about which titles you need, please contact a SAS Representative:

SAS Books
SAS Campus Drive
Cary, NC 27513-2414
Phone: 1-800-727-0025
Fax: 1-919-677-4444
Email: sasbook@sas.com
Web address: sas.com/store/books
## Index

### A
- access permissions
  - capabilities 44
groups 43
- roles 44
- SAS identities 42
- accounts
  - capabilities 44
  - roles 44
  - SAS identities 42
administration overview 1
administrators
  - administrative group 43
- Archive File type channels 62
- assessing models
  - tasks by user groups 50

### C
- capabilities 44
- champion models
  - monitoring performance tasks by user groups 51
- channel folders, creating 67
- channels
  - See publication channels
configuration
  - channels and subscribers 65
  - publication channels 61
  - SAS Workflow 55
configuring
  - dashboard reports 26
  - number of observations 34

### D
- dashboard reports 26
- defining HTTP or HTTPS servers 63
- defining publish locations for SAS
  - Content Server 64
- defining SAS Application Server 19
- delivering models
  - tasks by user groups 51
- deploying models
  - tasks by user groups 51

### G
- general tasks 52
- groups 43
  - creating 47
  - Public 43
  - SAS Users 43

### H
- HTTP or HTTPS servers
  - defining 63

### I
- importing models
  - tasks by user groups 50
- installing SAS Model Manager
  - installing additional products 9
  - pre-installation requirements and steps 3
  - running the SAS Deployment Wizard 9
- Instructions.html file 12

### L
- limit number of observations 34
- Log on as a batch job 15

### M
- metadata
  - access to 43
- MMChannel 62
- models
  - assessing tasks by user group 50
  - deploying and delivering tasks by user groups 51
  - importing tasks by user groups 50
  - monitoring champion model performance
    - tasks by user groups 51
O
operating system accounts
users 14
operating system requirements 3

P
performance
monitoring champion model
performance by user groups 51
permissions
capabilities 44
groups 43
roles 44
SAS identities 42
WebDAV folders 17
post-installation
configuration 12
verification 12
post-upgrade steps 39
pre-installation requirements and steps 3
pre-installation steps 3
pre-installation tasks
database 5
projects
setup tasks by user groups 49
publication channels
Archive File type 62
configuring 61
creating channel folders 67
creating new channels 68
creating new subscribers 68
MMChannel 62
Publishing Framework plug-ins 65

R
roles 44
creating 47
modifying 48

S
SAS Application Server
defining 19
SAS Content Server
defining publish locations 64
SAS Deployment Wizard
running 9
SAS identities 42
SAS Intelligence Platform
security administration 42
SAS Management Console
Publishing Framework plug-ins 65
SAS Publishing Framework 61
See also Publishing Framework plug-ins
scoring result set
limit number of observations 34
security
capabilities 44
groups 43
roles 44
SAS identities 42
SAS Intelligence Platform 42
setup
of projects and versions by user groups 49
setup tasks by user groups 49
subscribers to channels, creating 68

tasks
general, by user groups 52

U
upgrade steps 37
upgrade tasks
overview 37
post-upgrade steps 39
upgrade-in-place
See upgrade steps
user accounts
create 14
user IDs
SAS identities 42
user-defined templates
permissions 17

V
versions
setup tasks by user groups 49

W
WebDAV folders
creating as publishing locations 64
permissions 17
Windows
Log on as a batch job 15
workflow
configuring 55
Gain Greater Insight into Your SAS® Software with SAS Books.

Discover all that you need on your journey to knowledge and empowerment.

support.sas.com/bookstore for additional books and resources.